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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2003 – 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP software support web site at:

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Concepts
This chapter introduces the basic concepts of the HP OpenView Smart Plug-in for Microsoft 

Exchange Server (Exchange SPI), which works together with HP OpenView Operations for 
UNIX versions 7.x and 8.x, to monitor Microsoft Exchange 5.5, 2000, 2003, and 2007. 

The chapter includes the following sections:

• What the Exchange SPI does

• OVO UNIX 8.0 DCE and HTTPS agents

• How the Exchange SPI works

• Exchange organization

• Exchange SPI components:

— Exchange SPI Discovery

— Exchange SPI Service Maps

— Exchange SPI Policy groups and Policies

— Exchange SPI Application groups and Applications

— Exchange SPI Message groups and Messages

— Exchange SPI Reports and Graphs
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What the Exchange SPI Does

The Exchange SPI enables you to oversee your distributed Exchange environment from a 
central, easy-to-use console. With the help of the Exchange SPI, you can:

— Increase Exchange availability and performance

— Reduce support costs associated with the Exchange services

— Improve capacity management and planning for Exchange

With the Exchange SPI integrated into the HP OpenView Operations (OVO), you can apply 
the HP OpenView performance and problem management processes that you use for networks 
and systems to monitor Microsoft Exchange Server.

After you install and configure, the Exchange SPI will monitor critical Exchange application/
database resources including:

— Processes (for monitoring the amount of CPU time being used by core Exchange 
processes)

— Inactive Processes (for monitoring core Microsoft Exchange processes for activity and 
status)

— Exchange Services (for monitoring Exchange Server processes for activity levels)

— Message Transfer Agent (MTA) and Simple Mail Transfer Protocol (SMTP) message 
process data

— MTA Work Queue and SMTP Queues

— IS Public and Private/Mailbox Average Delivery Time

— Cluster environments.

The Exchange SPI sends the information to the OVO console through messages and alerts. 
You can also view the information in the form of reports or graphs. 

OVO UNIX 8 DCE and HTTPS Agents 

The Exchange SPI supports the new HTTPS agent, which comes with out-of-the-box HTTP 
authentication and SSL encryption, with server and client certificates, guaranteeing secure 
communication with the HP OpenView Operations central management servers. The new 
agent is available for all popular operating system platforms, including HP-UX, Microsoft 
Windows, Linux, and Solaris. 

When you upgrade from OVO 7.x to OVO 8.x and install the new agent, no manual 
configuration is necessary. 

Upgrading an Exchange node from DCE to HTTPS:

If an Exchange server node is already managed under a DCE agent, make sure the OVPA log 
files are cleared before re-managing it under HTTPS. 

To clean the log files, run the following command:

C:\usr\OV\bin\OpC\monitor\ddfutil.exe 
"C:\usr\OV\exspi\dsi\log\exspi_data" -rm all
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How the Exchange SPI Works

The Exchange SPI collects data from managed nodes according to rules and schedule 
specifications contained within the Exchange SPI policies. The Exchange SPI collects data 
related to health, availability, and performance of Microsoft Exchange Server. The Exchange 
SPI stores the collected data to a data store on the managed node and sends alert messages to 
the OVO message browser.

How the Data Collection Occurs 

When the collection’s scheduled time occurs, the Exchange SPI collector/analyzer program is 
executed and if required, forwards metric values to OVO and the HP data collecting agent. At 
the same time, OVO checks against predefined threshold settings and triggers alarms when 
violations occur. 

The collected data is written to a log file residing on the managed node, at pre-defined 
intervals. 

Messages appear in the OVO Message Browser with message details containing instruction 
text to help diagnose and remedy problems. If PerfView is present, metric values are available 
as graphs. If Reporter is installed, reports are available.
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Exchange Organization

The Exchange organization in an enterprise can be extremely complex, the diagram below 
might help in keeping an overview:
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Exchange SPI Components

The following components appear in the HP OpenView Operations for UNIX when Exchange 
SPI is installed:

• Exchange SPI service discovery

• Exchange SPI service maps

• Exchange SPI policy groups and policies

• Exchange SPI application groups and applications

• Exchange SPI message groups and messages

• Exchange SPI reports and graphs.

Exchange SPI Service Discovery

The Exchange SPI discovers Exchange services on OVO managed nodes. Exchange service 
discovery requires the HP OpenView Service Navigator, which can be installed on the 
management server with other components when OVO is installed initially, or installed alone 
at a later date. Refer to the OVO Installation Guide for more details.

See the section Exchange SPI Service Discovery chapter 4 page 93 for more information on 
Service Discovery functionality.

Exchange SPI Service Maps

The service graph generated by the Exchange SPI Service Discovery application is a snapshot 
of the Exchange services on the managed nodes at the time at which the application is run. 
The discovered Exchange topology is maintained in OVO and dynamic views are available of 
its current state in the service maps and views.
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Figure 1 Example Service Map

Exchange SPI Policy Groups and Policies

Policies measure collected data against predefined rules, generating alarms and messages to 
assist in problem analysis and resolution. Corrective actions are suggested in help text 
available in the message details.

Installing the Exchange SPI adds the SPI for Exchange policy folder to the OVO console tree. 
Double click SPI for Exchange to display the Exchange 2007, Exchange 2003, Exchange 2000,  
Exchange 5.5, and Exchange Service Discovery folders beneath. Double-click to open a folder 
and see the EXSPI policy groups for that version of Microsoft Exchange Server. Selecting a 
policy group in the console tree will display the policies, or policy sub-groups within that 
group, in the details pane on the right.

Policies can be distributed as groups or individually. For a complete listing of policies, see the 
HP OpenView Smart Plug-in for Microsoft Exchange Server Reference Guide.

 In OVOU 8 and earlier, policies were referred to as templates.
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Microsoft Exchange Server Version and EXSPI Prefix

This version of the Exchange SPI monitors Microsoft Exchange 2007, 2003, 2000 and 5.5. 
policy and policy group names contain the version number in the prefix, where 8X refers to 
Exchange 2007, 6X refers to Exchange 2000 and 2003, 65 to Exchange 2003 only, 60 to 
Exchange 2000 only, and 55 to Exchange 5.5. For example, where an Exchange 5.5 policy has 
the name EXSPI-55 Event Log Errors, the equivalent Exchange 2000 and 2003 policy is 
EXSPI-6X Event Log Errors. 

When policies or policy groups are referred to that work for both versions, they are referred to 
in this guide as EXSPI-60/55 <policy name>.

For a complete listing of policies with detailed policy by policy specifications, see the HP 
OpenView Smart Plug-in for Microsoft Exchange Server Reference Guide.

Policy Groups

The top level of the Policy Groups is:

SPI for MS Exchange

Exchange 2007

Exchange 2000

Exchange 2003

Exchange 5.5

Exchange Service Discovery

Exchange 2000 and Exchange 2003:

The policies for Exchange 2000 and 2003 are organized into Specialized Groups and Standard 
Groups. In those folders the policies are arranged in the following groups:

EXSPI Specialized Groups

• EXSPI Exchange Server

– EXSPI Message Delivery

– EXSPI Server Availability

– EXSPI Server Transaction Logs

• EXSPI Site Replication Server

EXSPI Standard Groups (Ex2000) or (Ex2003)

• EXSPI Availability

• EXSPI Client Access (Ex2000) or (Ex2003)

– EXSPI IMAP4

– EXSPI MAPI

– EXSPI OWA

– EXSPI POP3

• EXSPI Cluster (Ex2000) or (Ex2003)

• EXSPI Directory

• EXSPI Information Store (Ex2000) or (Ex2003)
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– EXSPI Epoxy (Ex2000) or (Ex2003)

– EXSPI Full Text Index

– EXSPI Mailbox (Ex2000) or (Ex2003)

– EXSPI Performance (Ex2000) or (Ex2003)

– EXSPI Public Folder (Ex2000) or (Ex2003)

– EXSPI Transaction Log

– EXSPI Virus Scan

• EXSPI Messaging

– EXSPI MTA

– EXSPI NNTP

– EXSPI SMTP

– EXSPI Tracking Log

• EXSPI OVO Exchange SPI core

– EXSPI Data Collection

• EXSPI Optional Services (Ex2000)

– EXSPI Chat Service

– EXSPI Conferencing Service

– EXSPI Instant Messaging

For a complete listing of policies, see the HP OpenView Smart Plug-in for Microsoft Exchange 
Server Reference Guide.

Exchange 5.5:

The EXSPI-55 Quick Start policy group contains policies that are easy to install and 
distribute and require no special customization. Many policies in the EXSPI-55 Add-Ons and 
EXSPI-55 Advanced policy groups require a more advanced configuration procedure. Before 
getting started, review policy requirements in Exspi Policy Group Requirements on page 71. 

Exchange Service Discovery

This group contains EXSPI_Discovery, EXSPI-6x Exchange Cluster Discovery SysLog and 
EXSPI-6x Exchange Cluster Discovery policies for service discovery.

Policy Types 

Within the Exchange group are:

•  Schedule policies that determine when and what metrics are collected

•  Monitor policies that implement the actual metric condition (threshold, object, message 
text, instructions, etc.) 
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• Message policies that intercept the Exchange SPI messages

• Logfile encapsulator policies that monitor for Exchange server related messages in the 
Windows event log, and send them to the OVO Message browser. 

For information on customizing policy settings, see Basic Customization on page 97.

Exchange SPI Application Groups and Applications

The Exchange SPI applications enable you to perform certain tasks on managed nodes to 
simplify monitoring Microsoft Exchange Server. Applications also help you configure the 
managed nodes to facilitate data collection process.

You can view the Exchange SPI applications in the OVO Application Bank window under 
EXSPI Admin, in the Exchange 2007, Exchange 2000 and 2003, and Exchange 5.5 
application groups. To open the OVO Application Bank, select Window > Application Bank.

Figure 2 EXSPI Admin Application Group in the OVO Application Bank Window
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Exchange 2000 and 2003 Applications

Figure 3 Exchange 2000 and 2003 Exchange SPI Applications

In the Exchange 2000 and 2003 group are the following applications:

• EXSPI Add DataSource: Exchange SPI application to configure data sources and start 
the logging of data.

• EXSPI MBOX Config: Starts the mailbox configuration program that automatically 
creates a mailbox.

— The script supports two options. The syntax is:        

exspi_e2k_cfg [-m mailBoxName] [ -ou OU ]

– -m (optional parameter) is the mailBoxName prefix.

– -ou (optional parameter) is the Organizational Unit.

– If the -m parameter is not specified, the default prefix is MSXSPI.

– The mailbox enabled service account is created as MSXSPI<hostname>. This 
mailbox name is added to the exspi\defaults file as line MAILBOX mailBoxName.

– If the -ou parameter is not specified, the mailbox will be created in the USERS 
container. 

— By default a mailbox named MSXSPI<hostname> is created on the Exchange server 
where "hostname " is the name of the Exchange server. 

— The mailbox is created hidden from the GAL.
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• EXSPI Node Config: Configures the service account with special Exchange privileges 
(MSXSPI) on the managed node. This account is for policies distributed in the Advanced 
Configuration section.

• EXSPI Ping Config: Configures the Advanced Configuration policy: End To End 
Message Ping.

• Self-Healing Info: This application gathers system information (command output, 
configuration, log and trace files), and writes this data to a file which HP support services 
can use during troubleshooting. For more information, see Self-Healing Information for 
Enhanced Troubleshooting on page 132. 

• Enable Message Tracking (for Exchange 2000 and 2003 only): Turning message 
tracking on will cause the Exchange server to write tracking log files. The Exchange SPI 
track log schedule policy parses these log files to collect data for the four tracklog reports: 
Exchange Top Destinations, Exchange Top Recipients, Exchange Top Senders, and 
Exchange Top Sources.

• Enable EXSPI Tracing: Enables tracing; default setting is OFF. This application is 
generally used for troubleshooting. When tracing is turned on the results are written to:  
%OvAgentDir%\exspi\log\trace.                                              Note: The trace file will 
grow very large. It is advisable to leave tracing enabled only long enough to recreate the 
problem, or in order to comply with HP support instructions.

• Disable EXSPI Tracing: Disables tracing; (default tracing setting is OFF). 

• Enable Data Logging: Starts Exchange SPI data logging, the default setting is ON. This 
is normally used after Disable Data Logging, to restart data logging.

• Disable Data Logging: Stops Exchange SPI from logging data.

• EXSPI Cluster Config: The Exchange Cluster Config application prints apminfo data, 
which can be used to create the apminfo.xml file used by the Exchange SPI to recognize 
clustered instances. For further information about Exchange SPI monitoring clusters, see 
Using Exchange SPI in high availability environments on page 89. Regarding 
privileges: This application can be run as any account that has the ability to read wmi, 
such as a Domain admin or an Exchange admin account

• Mount Exchange DB: This application can search for and mount dismounted mailboxes 
or public folder store databases. It requires the user name and password of a special 
account that has Exchange administrative privileges, as the application must be modified 
with this info before executing, see Creating a Service Account with Proper Access 
Permissions on page 25. 

     The application can take one or all of the following parameters: 

— -s    Search for dismounted databases.

— -m  Search for dismounted databases and attempt to mount any found.

— -p   Print the output.

— -a   Forward an alarm message to the OVO Management server.

— -t   Timeout: the time the tool can take to re-mount a dismounted database (in 
seconds). If not provided, the script will automatically set the timeout value to be 5 
seconds. If the database cannot be remounted within the time frame given, you can set 
a higher timeout value, e.g. 30 seconds. If remounting the dismounted database still 
fails, and there is not an error in the output of the tool, there is probably a problem 
with the Exchange information store service. 
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• EXSPI List CODA Data Sources: Lists the data sources and objects in CODA. Run it 
after executing "EXSPI Add DataSource" so you know if the EXSPI_DATA data source 
was created or not. 

Exchange 5.5 Applications

Figure 4 Exchange 5.5 Exchange SPI Application Group.

In the Exchange 5.5 group are the following applications:

• EXSPI Add DataSource: Exchange SPI application to configure data sources and start 
the logging of data.

• EXSPI MBOX Config: Starts the mailbox configuration program that automatically 
creates a mailbox.

• EXSPI Node Config: Configures the service account with special Exchange privileges 
(MSXSPI) on the managed node. This account is for policies distributed in the Advanced 
Configuration section.

• EXSPI Ping Config: Configures the Advanced Configuration policy: End To End 
Message Ping.

• Self-Healing Info: This application gathers system information (command output, 
configuration, log and trace files), and writes this data to a file which HP support services 
can use during troubleshooting. For more information, see.Self-Healing Information for 
Enhanced Troubleshooting on page 132. 
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• Enable EXSPI Tracing: Enables tracing; default setting is OFF. This application is 
generally used for troubleshooting. When tracing is turned on the results are written to:  
%OvAgentDir%\exspi\log\trace.                                              

• Disable EXSPI Tracing: Disables tracing; (default tracing setting is OFF). 

• Enable Data Logging: Starts Exchange SPI data logging, the default setting is ON. This 
is normally used after Disable Data Logging, to restart data logging.

• Disable Data Logging: Stops Exchange SPI from logging data.

• Exchange 5.5 Graphs:  Exchange SPI graphs are located here.

Exchange SPI Message Groups and Messages

Figure 5 OVO Message Group Bank Window

There are three Exchange SPI message groups located in the OVO Message Group Bank 
window and all messages generated by the Exchange SPI fall into one of these message 
groups. They are:

1 EXSPI: contains messages generated by Exchange-SPI programs. They contain 
instruction text to help to diagnose/remedy problems.

2 EX_Perf: contains messages regarding Exchange performance.

3 EX_Fault: contains messages regarding error conditions.

The trace file will grow very large. It is advisable to leave tracing enabled only long enough to 
recreate the problem, or in order to comply with HP support instructions.
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Exchange SPI Reports and Graphs

Exchange SPI Reports

Exchange SPI reports come in a separate package, EXSPI-Reporter.msi which is found in 
the HP OpenView Operations for Unix Application CD-ROM. HP OV Reporter can be used to 
access the Exchange SPI data source (EXSPI_DATA) on managed nodes, and generate reports 
using Seagate Crystal Reports. 

For Exchange 2003 and 2000 reports, see Exchange SPI Reports on page 110, and Reports for 
Exchange 5.5 Servers on page 117, for complete lists of out-of-the-box Exchange SPI reports.

Exchange SPI Graphs

Exchange SPI graphs include HP OpenView Performance Manager (OVPM) graphs for 
Exchange 5.5, 2000, 2003, 2007 and PerfView graphs for Exchange 5.5. OVPM graphs require 
an installation procedure. See Installing Exchange SPI Graph policies on page 121 for details.

For a list of available graphs, see Exchange 2003 OVPM Graphs on page 122, Exchange 2000 
OVPM Graphs on page 125, and Exchange 5.5 OVPM Graphs on page 127.
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2 User Privileges
Introduction

The Exchange SPI collects data from many sources. In order to collect some types of data, the 
Exchange SPI requires advanced user credentials. 

This chapter outlines:

• Which policies/applications have user account requirements

• For policies and applications requiring specific user permissions, how to create the service 
account and grant proper access permissions in the following environments:

— Exchange 5.5 nodes in a Windows NT domain

— Exchange 5.5 nodes in a Windows 2000 domain

— Exchange 2000/2003 nodes in a Windows 2000/2003 domain
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User Privileges

There are two levels of user privilege needed by the Exchange SPI:

1.   $AGENT_USER

All schedule policies without the "-s" option run as $AGENT_USER.  This level of user 
privilege is sufficient for the following schedule policies:

-- All policies in Exchange 5.5 Quick Start group, and some policies in the Exchange 5.5 
Add-Ons and Advanced groups.  

-- Some Exchange 2000 and 2003 policies in both the Standard and Specialized groups.

See Exspi Policy Group Requirements on page 71 for more information about which policies 
require the service account with special Exchange privileges.

2.   Service account user with special Exchange privileges

APPLICATIONS 

For all versions of Exchange, the following applications need to run with this special type of 
service account:

— Enable Message Tracking

— EXSPI MBOX Config.

POLICIES

For Exchange 5.5: 

Some policies in the Add-Ons and most policies in the Advanced group run under this type of 
account (all the policies which include the -s parameter):

— EXSPI Advanced > EXSPI End to End Message Ping > EXSPI-55/6X End to End 
Message Ping. These policies use the mailbox created by the Exchange SPI application 
EXSPI MBOX Config.

— EXSPI Advanced > EXSPI Reporter Collection > all policies.

For Exchange 2000 and 2003: 

All policies in the EXSPI Specialized Groups require to run under this type of account.

See Exspi Policy Group Requirements on page 71 for more information about which policies 
require the service account with special Exchange privileges.
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Creating a Service Account with Proper Access Permissions

Some policies and applications require a service account for each logon domain where 
Exchange servers reside (see Exspi Policy Group Requirements chapter 4  page 71). This 
service account enables the Exchange SPI to access information from the Exchange database. 
This is required only for Exchange 2003, 2000, and 5.5.

The service account must be created and the access privileges granted. Procedures are 
outlined according to operating system environment, in the following manner:

— Case 1: For Exchange 5.5 nodes in a Windows NT Domain (Note: Windows NT is only 
supported under OVO 7).

— Case 2: For Exchange 5.5 nodes in a Windows 2000 Domain

— Case 3: For Exchange 2000/2003 nodes in a Windows 2000/2003 Domain
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Exchange 5.5 nodes in a Windows NT Domain 

Create User Account 

1 Log on as Domain Administrator of the domain to which the Exchange server belongs. 

2 Select Start > Programs > Administrative Tools (common) > User Manager for 
Domain.

3 Select User > New User. In the dialog that appears create a new user as follows:

Figure 6  User Manager dialog 
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Figure 7 New User dialog 

4 Deselect User Must Change password at Next Logon and select Password Never 
Expires.

5 Click the Groups button to display the Group Memberships window.

 Username:  MSXSPI

 Full Name:  OVO Exchange SPI 

 Description:  Exchange SPI for OVO 

 Password/Confirm Password:  *********

Remember this password; you will need it later to update applications and 
policies.

This password must be entered but will not be authenticated later.
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Figure 8  Group Memberships dialog

6 At the right, from the Not a member of: box select the Domain Admins user, click Add, 
and OK to close the Group Memberships window.

7 To include necessary information, click buttons in the New User window:  

8 Click Add to add this user. (If the Exchange Add Mailbox window is displayed, select 
Cancel to close it).

9 Click the Close button to close the New User window.

10 From the User Manager menu bar select Templates > User Rights....

 Profile:  No User Profile should be specified.

 Hours:  All hours of the day and week should be allowed.

 Logon To:  All workstations should be specified.

 Account:  Should never expire/should be Global Account.
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Figure 9  User Manager dialog

11 Check the Show Advanced User Rights checkbox.

12 From the drop-down list select Log on as a service in the Right field

Figure 10  Selecting Log on as a service for User Rights.

13 Click the Add button to open the Add Users and Groups window.
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14 Click the Show Users button.

15 Select the user account just added (MSXSPI), click Add, then OK.

Figure 11  Adding the new User Account

16 Repeat steps 12-15 to add the Profile system performance right.

17 Open Active Directory Users and Computers.

18 Right-Click on the domain to which the Exchange server belongs and click Properties.

19 Choose the Group Policy tab and select the Default Domain Policy.

20 Click Edit. Browse to Computer Configuration > Windows Settings > Security 
Settings > Local Policies > User Rights Assignment.

21 Double-click Log on as a Batch Job group policy and add the MSXSPI account to this 
policy.

Grant Exchange Access Permissions to User Account 

In order for the user account (in this example MSXSPI) to have access to a mailbox as well as 
the Exchange IS Public and Private databases, it must have Exchange Admin permissions. 
Use Exchange Administrator to grant these permissions at the site level.

1 Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.

2 For each Exchange site where Advanced policies are to be distributed: In the left pane 
within the tree, select <site_name>.

a From the File menu select Properties.
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b In the Properties window, select the Permission tab and click Add to open the Add 
Users and Groups window.

c Select the user account previously created (MSXSPI), and click Add.

d Click OK to add the user, and close the Add Users and Groups window.

e Verify the user has the role of Admin.

Figure 12  Verifying the User role

f Click OK to save the changes.
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Exchange 5.5 nodes in a Windows 2000 Domain 

Create User Account

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Programs > Administrative Tools > Active Directory Users and 
Computers.

3 Expand the Active Directory of Users and Computers, right-click Users, and select New > 
User.

Figure 13  Selecting New User dialog

4 In the dialog box that appears, enter the user name just created (in this example 
MSXSPI) as the First Name and as the User logon name.
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Figure 14  New object dialog

5 In the next window, enter Password/Confirm Password for the user account (MSXSPI).

6 Select Password Never Expires. Then click Next

Figure 15  Setting User Privileges.
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7 In the New Object dialog, deselect Create an Exchange mailbox, and click Next.

Figure 16  Deselect Create an Exchange Mailbox

8 In the next dialog, complete creating the user by clicking Finish.

9 You are now back at the Active Directory Users and Computers dialog. In the right 
pane, right-click on the user just created (in this example MSXSPI) and select 
Properties.

10 In the MSXSPI Properties page, select the General tab. Enter “Exchange SPI for 
OpenView Operations for Windows” in the Description field.
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Figure 17  Properties dialog

11 Select the Member Of tab. Click Add
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Figure 18 Setting User account privileges

12 In the Select Group dialog select Domain Admins from the top pane. Click Add, then 
OK.

13 The new user (MSXSPI) is now a member of Domain Admins group. Click OK and exit the 
Active Directory Users and Computer dialog.

14 Open Active Directory Users and Computers.

15 Right-click on the domain to which the Exchange server belongs and click Properties.

16 Choose the Group Policy tab and select the Default Domain Policy.

17 Click Edit. Browse to Computer Configuration > Windows Settings > Security 
Settings > Local Policies > User Rights Assignment.
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18 Double-click the Log on as a Batch Job group policy and add the MSXSPI account to 
this policy.

Figure 19  New User with new Membership status

Grant Exchange Access Permissions to User Account 

In order for the user account MSXSPI to have access to a mailbox as well as the Exchange IS 
Public and Private databases, it must have certain Exchange Admin permissions. Use 
Exchange Administrator to grant these permissions at the site level.

1 Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.

2 For each Exchange site where Advanced policies are to be distributed:

a In the left pane within the tree, select <site_name>.

b From the File menu select Properties.In the Properties window, select the 
Permission tab and click Add to open the Add Users and Groups window.

c Select the user account previously created (MSXSPI), and click Add.

d Click OK to add the user, and close the Add Users and Groups window.
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e Verify the user has the role of Admin.

Figure 20  Verifying User roles.

f Click OK to save the changes.
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Exchange 2000/2003 nodes in Windows 2000/2003 Domain 

To create a service account with special Exchange privileges for Exchange 2000/2003 nodes 
the following steps are required:

Task 1: Enable viewing of the Administrative Groups folder

Task 2: Create the service account

Task 3: Add the service account user to the Local Administrators group.

Enable Viewing of Administrative Groups folder

To create the user account it is necessary to first enable viewing the administrative groups 
folder:

1 Open the Exchange server Properties

2 Select Display administrative groups.

3 Click Apply and OK.

Create User Account

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Settings > Control Panel > Administrative Tools > Active Directory 
Users and Computers.

3 Expand the Active Directory Users and Computers and right-click Users and select New 
> User.
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Figure 21 Active Directory Users and Computers dialog

4 In the New Object - User dialog, enter a user name for the new service account into the 
First Name and the User logon name fields.  

You must create a service account with these privileges in each Windows domain. 
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Figure 22 Entering the new service account name   

1 In the next window, enter Password/Confirm Password for the service account.

2 Select Password Never Expires. Then click Next.

Figure 23 Setting password properties   
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3 In the New Object dialog, deselect Create an Exchange mailbox, and click Next

Figure 24 Deselecting creating a mailbox   

4 In the next dialog, complete creating the user by clicking Finish.

5 You are now back at the Active Directory Users and Computers dialog. In the right 
pane, right-click on the service account user just created and select Properties.

6 In the service account Properties page, select the General tab. Enter OVO Exchange 
SPI in the Display name and Description fields.

Figure 25 Entering names in Properties dialog   

7 Select the Member Of tab, and click Add.

8 In the Select Group dialog select Exchange Domain Servers from the top pane.

9 Click OK and exit the Active Directory Users and Computer dialog.

10 Open Active Directory Users and Computers.

11 Right-click on the domain to which the Exchange server belongs and click Properties.

12 Choose the Group Policy tab and select the Default Domain Policy.
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13 Click Edit. Browse to Computer Configuration > Windows Settings > Security 
Settings > Local Policies > User Rights Assignment.

14 Double-click the Log on as a Batch Job group policy and add the MSXSPI account to 
this policy.

Figure 26 Confirming membership privileges   

g Add the service account user to the Local Administrators group on the Exchange 
server. 

a On each targeted Exchange 2000/2003 server, select Start > Settings > Control 
Panel. 

b Double click Administrative Tools. Double click Computer Management, then 
open the Local Users and Groups folder. Select and open the Groups folder, then 
double click Administrators.

c In the Administrators Properties dialog, click the Add button. Select the correct 
Domain from the Look in drop down list. Select the new service account user from 
the list, and click Add. Click Apply and then OK.
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Figure 27  Adding service account user to Local Administrators group

It can sometimes take a few hours for new group membership and rights to be 
applied to a service account.
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3 Installation and Configuration
This chapter offers instructions for installing, configuring and removing Exchange SPI 
components. It covers the following topics:

• Prior to installing Exchange SPI

• Installing and configuring the Exchange SPI

• Policy Groups: installation considerations

• Installation and Basic Configuration

• Advanced Configuration

• Removing the Exchange SPI

• Deleting Exchange SPI policies, applications and message groups. 

Prior to Installation

• This release is targeted at OVO for UNIX 7.x or higher. Verify your current OVO version.

• Before installing this version of the Exchange SPI, you must remove any previous version 
of the Exchange SPI (see Removing the Exchange SPI on page 65).

• The installation of Exchange SPI depends on the following pieces of software, verify that 
they are present on the management server before installing the Exchange SPI: 

— DSI2DDF A.01.30.00 or higher (for OVO7 and OVO8/DCE) 

— DSI2DDF A.02.00.00 or higher (for OVO8/HTTPS).

— SPI-SHS-OVO (version = A.01.00).

• Exchange SPI reports require HP OpenView Reporter, and the Exchange SPI 
EXSPI-Reporter.msi must be installed on a Windows node in the same domain where 
Exchange SPI is managing nodes.

• Self healing collector must be present on management server (version 8.01.xx).

• Service Discovery Framework (SPI-SVCDISC-OVO) version A.02.xx must be present on 
management server.

Pre-Installation Task

Before the start installing the Exchange SPI on the management server, make sure that you 
have installed OVO UNIX agents on the management server.
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Installing the Exchange SPI

To install the Exchange SPI on the OVO management server from the command line 
interface, follow these steps: 

1 Insert the Exchange SPI DVD into the CD-ROM drive of the management server.

2 Run the following command:

For an HP-UX 11.0 management server, enter:

swinstall -s /cdrom/OV_DEPOT/11.OHPUX.sdtape SPI-EXCHANGE-OVO

For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape SPI-EXCHANGE-OVO

The installer installs the Exchange SPI on the management server.

Configuring the Exchange SPI

After you install the Exchange SPI, you must configure it to monitor the Microsoft Exchange 
Server nodes in your organization. The configuration process involves adding nodes to the 
management server, enabling the Exchange SPI to discover nodes, and so on.

Prerequisite

Before you start configuring the Exchange SPI, you must create a Microsoft Exchange user 
account with necessary user privileges, which can be used by the SPI to achieve service 
discovery.

Create a user on the domain controller with the user name— msxspi. This user must be 
member of the following groups:

— Administrators

— Domain Admins

— Domain Users

In addition, if you want to monitor Microsoft Exchange Server 2007, the msxspi user must be 
a member of the Exchange Organization Administrators group.

If you want to monitor Microsoft Exchange Server 2003/2000, the msxspi user must be a 
member of the Exchange Domain Servers group.

Add Nodes

After you install the Exchange SPI on the OVO management server, a new node group—
EXSPI—is created. You must add all Microsoft Exchange Server nodes to this group. To add 
Exchange nodes to the EXSPI node group, follow these steps:

1 In the Root window, click Window → Node Group Bank. The OVO Node Group Bank window 
opens.

2 In the Root window, click Window → Node Bank. The OVO Node Bank window opens.
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3 Select a node in the OVO Node Bank window, and then drag and drop the node on EXSPI 
in the OVO Node Group Bank window.

4 Repeat step step 3 to add another available node.

Alternatively, follow these steps:

1 In the root window, click Window → Node Group Bank. The OVO Node Group Bank window 
opens.

2 In the OVO Node Group Bank window, double-click EXSPI. The Node Group: EXSPI 
window opens.

3 In the Node Group: EXSPI window, click Actions → Node → Add. The Add Node dialog box 
opens.

4 Specify details of the Exchange node that you want to add, and then click OK.

5 Repeat step 2 to step 4 to add another node.

If you do not select to automatically install agent software on nodes, you must manually 
install agents on the added nodes. Refer to the following documents for more information on 
agent installation on nodes:

• HP OpenView Operations Administrator’s Reference

• HP OpenView Operations OVO DCE Agent Concepts and Configuration Guide

• HP OpenView Operations OVO HTTPS Agent Concepts and Configuration Guide

If you want to monitor Microsoft Exchange Server 2007 nodes, agents must run on the nodes 
with a  user account that has privileges to perform the following:

• Act as part of the operating system

• Adjust memory quotas for a process

• Replace a process level token

Distribute the Exchange SPI Actions, Monitors, and Commands

To collect data from Microsoft Exchange Server nodes, you the Exchange SPI actions, 
monitors, and commands must be available on nodes. To distribute the Exchange SPI actions, 
monitors, and commands, follow these steps:

1 In the OVO Node Group Bank window, click EXSPI, and then click Actions → Agents → 
Install/Update SW & Config. The Install/Update OVO Software and Configuration window 
opens.

2 In the Install/Update OVO Software and Configuration window, click the following 
components:

— Actions

— Monitors

— Commands
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3 Click Nodes in list.

4 Click Force Update.

5 Click OK.

After successful distribution, the following message is displayed in the message browser:

The following configuration information was successfully distributed: 
Actions, Commands, Monitors
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Update the remactconf.xml File

If you use DCE agent based nodes, you must update the remactconf.xml file to enable the 
discovery policy to run automatic actions on the management server. Follow these steps:

1 Open the remactconf.xml file from the following location on the management server:

/etc/opt/OV/share/conf/OpC/mgmt_sv/

2 Add the following content to the file:

<rule>

    <doc>allow all DCE-agent actions</doc> 

    <if> 

     <certified>false</certified> 

    </if> 

    <allow/>

</rule>

Run the EXSPI Node Config Application

To run the EXSPI Node Config application (EX2007 Node Config for Exchange 2007 nodes), 
follow these steps:

1 Select all the desired Exchange managed nodes. 

2 Drag these nodes and drop them on the EXSPI Node Config application located in the 
EXSPI Admin application group. 

3 When prompted, enter the domain, user and password for the user account (the account 
mentioned in Prerequisite on page 46). 

If you use HTTPS agent based nodes, verify and make sure that the remactconf.xml file in 
the /etc/opt/OV/share/conf/OpC/mgmt_sv/ location on the management server 
contains the following content:

<rule>

    <doc>Allow ALL certified actions</doc>

    <allow/>

</rule>

When you run this application, be sure to enter the correct domain name, user and 
password. This domain is not the DNS domain name but the NT domain name. 
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If you add additional nodes after running this application, you must run this application 
on all newly added nodes.

Initiate Data Collection for Exchange 2007

If you are using Microsoft Exchange Server 2007, you must initiate the data collection process 
on nodes after running the Create DataSources application. The data collection mechanism on 
Exchange 2007 nodes are governed by two daemons — Collection Manager and PowerShell 
Collector. Before you start using the SPI for Exchange 2007 nodes, you must perform the 
following steps to initiate data collection:

1 Open the OVO Node Group Bank winddow.

2 In the OVO Node Group Bank window, double-click EXSPI. The Node Group:EXSPI 
window opens.

3 Run the Register Data Collector application to register COM components on Exchange 
2007 nodes. Perform the following steps:
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a From the Node Group:EXSPI window, drag and drop a node on Register Data 
Collector in the Application Group: Exchange 2007 window. The Output of Application 
No. 2 window appears.

b After the window displays output, click Close.

c Repeat step a and step b for all Exchange 2007 nodes.

4 Run the Create DataSources application to on nodes. Perform the following steps:

a From the Node Group:EXSPI window, drag and drop a node on Create DataSources in 
the Application Group: Exchange 2007 window. The Output of Application No. 3 
window appears.
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b After the window displays output, click Close.

c Repeat step a and step b for Exchange 2007 nodes.

5 Run the Start ExData Collection Manager application to start the Collection Manager 
daemons on nodes. Perform the following steps:

a From the Node Group:EXSPI window, drag and drop a node on Start ExData 
Collection Manager in the Application Group: Exchange 2007 window. The Output of 
Application No. 5 window appears. 

b Click Close.

c Repeat step a and step b for Exchange 2007 nodes.

6 Run the Start PowerShell Collector application to start the Start PowerShell Collector 
daemons on nodes. Perform the following steps:
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a From the Node Group:EXSPI window, drag and drop a node on Start PowerShell 
Collector in the Application Group: Exchange 2007 window. The Output of Application 
No. 4 window appears.

b Click Close.

c Repeat step a and step b for Exchange 2007 nodes.

Assign/Distribute Policies

To assign and distribute policies to managed nodes:

1 Open the OVO Node Bank.

2 Select the desired managed node(s) designated to run Exchange SPI.

3 To assign (select) the policies for distribution, click Actions → Agents → Assign Templates 
from the menu bar.

4 In the Define Configuration window, click Add.

5 In the Add Configuration window, click Open Template Window....

6 In the Message Source policies window double-click the SPI for Exchange group to display 
the subgroups.

7 Select, and double-click Exchange 2007, Exchange 2000, Exchange 2003, or Exchange 5.5. 

In OVO for UNIX version 8 and earlier, policies were also referred to as templates.
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8 Select the desired EXSPI policy group or individual policies.

9 Click Get Template Selections from the Add Configuration window.

10 Click OK from the Add Configuration window.

11 Click OK from the Define Configuration window.

12 The desired policies have been selected for distribution. Next, distribute them to the 
managed nodes.

13 To distribute the assigned policies, select Actions  → Agents → Install/Update SW & Config 
from the Node Bank menu. 

14 In the Install/Update OVO Software and Configuration window, check the Templates 
checkbox to select it.

15 Check the Nodes in List and the Force Update checkboxes.

16 If a node was not selected previously, select the node in the node bank and click Get Map 
Selections to list the target node(s), and then click OK to distribute policies to the 
managed node(s).

17 The following message appears in the message browser:

The following configuration information was successfully distributed: 
Templates

For Microsoft Exchange Server 2007, select the Exchange Service Discovery policy 
(EXSPI_Discovery_2k7) before selecting any other policy.
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Assign Responsibilities for OVO Operator

All Exchange SPI target hosts must be OVO managed nodes running on OVO intelligent 
agents. 

1 Log on to OVO as the OVO administrator (opc_adm).

a Select Window > User Bank

b Select the opc_adm user

c Choose Actions > User > Modify

d Press the Responsibilities button and use the Responsibilities for Operator 
(opc_adm) window to view messages.

Figure 28 The Responsibilities for Operator window

2 In the Node Group that contains your Exchange managed node, select the following 
Exchange SPI message groups:

— EXSPI

— EX_Fault

— EX_Perf

3 Use the Actions > Browser > Start/Reload from the OVO User Bank menu.

Additional Configuration for Microsoft Exchange Server 2003/
2000 and 5.5

You need perform some additional configuration steps depending on your requirement if you 
are using Microsoft Exchange Server 2003/2000 or 5.5.
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 Enable Message Tracking

To ensure that all messages routed through a server are added to the OVO message tracking 
logs you need to enable message tracking. You can record information about the sender, the 
message, and the recipient. If you need to log more detailed information, you can also record 
the subject line of the Email message.

 Enabling Message Tracking for Exchange 5.5

1 Select Start > Programs > Microsoft Exchange > Microsoft Exchange 
Administrator.

2 Expand the site level and Configuration to view selections beneath it.

3 In the details pane double-click Information Store Site Configuration.

4 In the Information Store Site Configuration Properties dialog, check Enable 
message tracking, and select OK.

Figure 29  Information Store Site Configuration dialog 

5 Repeat steps 3 and 4 for MTA Site Configuration.
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Figure 30  MTA Site Configuration dialog 

6  In the left pane select Connections.

7 In the right pane select Internet Mail Service, check the Enable message tracking 
checkbox, and click OK.

 Enabling Message Tracking for Exchange 2000 and 2003

Use the Exchange SPI application Enable Message Tracking to set message tracking on, 
for servers only. All messages that are routed through the selected servers will then be added 
to the message tracking logs. This information is collected by the EXSPI-6X Dc-TrackLog 
Data collection policies.You can record information about the sender, the message, and the 
recipient. If you need to log more detailed information, you can also record the subject line of 
Email messages.

The Enable Message Tracking application needs to be modified to include the user name 
and password of a service account that has Exchange administrative privileges. Open the 
Enable Message Tracking application, and add the user name and password.to the Execute 
as User field, before executing.

If the Internet Mail Service connector does not exist, skip the following steps.
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Figure 31 Enabling Message Tracking for Exchange 2000 and 2003

 Run the EXSPI MBOX Config Application and Create Mailboxes

In addition to the MSXSPI user, a mailbox is required for accessing mailbox and folder 
information, necessary for End to End Message Ping and Reporter Collection policies. Use the 
Exchange SPI application MBOX Config (located in the EXSPI Admin application group) to 
create the mailbox:

1 Modify the MBOX Config application. The user name and password of a service account 
with Exchange administrative privileges needs to be given for the application to execute. 
(Change the Execute as User field, add user name and password.) 

2 Run the EXSPI MBOX Config application to configure mailboxes for the Exchange 
servers (you can select multiple nodes simultaneously).

For each Exchange server a mailbox is created with the prefix MSXSPI and Windows 
hostname. For an Exchange 5.5 server, EXSPI MBOX Config application creates a mailbox 
MSXSPI<host_name> for the primary Windows account MSXSPI. For an Exchange 2000 or 
2003 server, it creates the mailbox MSXSPI<host_name> for account MSXSPI<host_name> 
(which it also creates.)

For example, for the node rosspi4.rose.hp.com (Internet name) and Windows name 
ROSSPI4 a mailbox is created called MSXSPIROSSPI4. 
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Figure 32 MBox Config application output

 Set Up Message Ping Server Connections and Alarms 

To measure the round trip time required for a message to travel from one server to another 
and then back to the originating server, you can use the EXSPI-6X/55 End to End Message 
Ping policy group. 

Before you can use the End to End Message Ping policies, you must configure the pair of 
servers that you want to test. 

In order to create a different mailbox with a different name, see the procedure 
Changing the Mailbox name on page 104.

If you receive an error in the above step or you cannot automatically create mailboxes, you 
must manually complete the following on each Exchange server:

1 For each Exchange server create a mailbox with the prefix MSXSPI and Windows 
hostname.

a For Exchange 5.5, create this mailbox with primary Windows account MSXSPI. 

b For Exchange 2000 or 2003, create this mailbox with primary Windows account 
MSXSPIROSSPI4 (this must first be created).

With Exchange SPI version A.08.00 and later, pinging Exchange 5.5 servers from an 
Exchange 2000/2003 server, or vice versa, is not supported.
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Exchange 5.5 Servers

To configure the servers, complete the following steps:

1 Run the EXSPI Ping Config application on the OVO management server. 

The EXSPI Ping Config application opens a default file as follows: 

Figure 33 Format of the file for Exchange 5.5 EXSPI Ping Config

2 Enter information about the servers to replace each entry separated by a colon (:) in the 
format Src-Srv:Src-MB:::Dest-MB:Timeout:MetSLA:AlmostMetSLA 

— Source Server - The server that the ping originates from. Each server where EX-SPI 
is distributed has the same file, so the EX-SPI collector/analyzer will parse this file 
and use all lines where the Source Server matches the server where it is run from.

— Destination Server - The destination server, used only for SMTP systems, is 
necessary only when the site directory does not contain the destination mailbox. In 
this case, SMTP is used and the field would contain the SMTP server name (the 
server following the "@"; for example, the entry for mailbox 
"brendan_belcastro@am.exch.hp.com", would contain "am.exch.hp.com." 
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— Destination Mailbox (required) -The mailbox to send the ping to. This field is 
usually the only required destination entry.

— Timeout (required) (s-seconds, m-minutes, h-hours): - If a sent message does not 
return in the defined timeout interval, EXSPI logs it as a failure and sends a message 
to OVO. Failed messages are tallied in terms of count and percentage within a report. 
The timeout value must be larger than the values for MetSLA and AlmostMetSLA 
so that a returned message can be processed using these values. It may have 
Exceeded SLA even though it has not exceeded the timeout interval. A Failed/
Timedout message occurs, therefore, only when the message never returns and the 
timeout period is exceeded.

— MetSLA (required for reports) (s-seconds, m-minutes, h-hours) -   If the round trip 
time is greater than this value, the message is logged as either Almost Met SLA or 
Exceeded SLA. This value is required if data is being sent to MeasureWare Agent DSI 
for reporting (-l option when running exspi_e2k.exe or exspi_e55.exe). It is optional if 
only using alarms.

— AlmostMetSLA (required for reports) (s-seconds, m-minutes, h-hours) - If the round 
trip time is greater than the MetSLA value but less than or equal to MetSLA plus 
AlmostMetSLA, the message is logged as Almost Met SLA. Otherwise, when the 
round trip time is higher than MetSLA plus AlmostMetSLA, it is logged as Clearly 
Exceeded SLA. This parameter is required if data is being logged to MeasureWare 
Agent DSI (-l option when running exspi_e2k.exe or exspi_e55.exe), optional if only 
using alarms.

Procedure for EXSPI Ping Config for Exchange 2000/2003 Servers

1 Select the Exchange managed nodes that you wish to configure in the VPO Node Bank.

2 Drag these nodes and drop them on the EXSPI Ping Config application located in the 
EXSPI Admin application group, under the appropriate Exchange version.

3 A window appears with the configuration file, as shown in the figure below.

4 Edit the file as necessary, then click Esc.

5 You will be prompted to save the configuration. Accept the default choice [Yes].

The minimum timeout value should be set slightly less than the collection interval. 
For example, if the collection interval for metric 1002 is 30 minutes (the default), the 
timeout should be set to at least 25 minutes. The logic is that because the next 
measurement occurs only every 30 minutes, you should allow up to that amount of 
time for any messages to return before "giving up" and generating a failure. If you 
keep the timeout value within the collection interval and the reply message does 
return, it can be processed as Met, Almost Met or Exceeded as opposed to Failed/
Timedout.

Timeout, MetSLA, and AlmostMetSLA values can have optional identifiers that 
denote the measurement units the value represents; for example, 4m (4 minutes) 30s 
(30 seconds) or 1h (1 hour). The default unit is seconds; for example, the entry 4 is 
recognized as 4 seconds.
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6 A validation will be performed to check if the Timeout is greater than the sum of MetSLA 
and AlmostMetSLA. After validation, you will be prompted to accept and install the 
configuration file in the monitors directory: /var/opt/OV/share/databases/OpC/mgd_node/
customer/ms/nt/monitor/

7 You have completed configuring the end-to-end Ping, now distribute monitors to the 
required EXSPI managed nodes. For details about distributing the monitors, see 
Distribute the Exchange SPI Actions, Monitors, and Commands on page 47.
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The format of the Exchange 2000/2003 EXSPI Ping Config file is:

Src-Srv:Dest-Srv:Timeout:MetSLA:AlmostMetSLA

The user only needs to fill in the following fields:

— Src-Srv

— Dest-Srv

— Timeout (to be entered in seconds, with no suffix)

— MetSLA (to be entered in seconds, with no suffix)

— AlmostMetSLA (to be entered in seconds, with no suffix).

Figure 34 EXSPI Ping Config for Exchange 2000 and 2003

Set Up Different Conditions/ Thresholds for Different Server Pairs Using OVO Object Field & Alarming     
(OVO High Level Expertise Recommended)

Alarms can be set to occur with metric EXSPI-60 1002 (Ping). Because you may need to set 
different thresholds for multiple server pairs, the following examples are offered. The 
examples show the syntax to insert in the policy Conditions, using the OVO object pattern 
fields so that you can set differing thresholds. Metric 1002 sends the 
"FromMailbox,ToMailbox" in the object pattern fields with the following definitions:

FromMailbox = FromServer:FromMailbox
ToMailbox    = [ToServer]:ToMailbox
where [ToServer] is optional

Config Entry Object

EXCH1:MSXSPIEXCH2:25m:1m:1m EXCH1:MSXSPIEXCH1,:MSXSPIEXCH2
EXCH1:MAILBOXEXCH1:
MAILOXEXCH3:2h:5m:2m

EXCH1:MAILBOXEXCH1,:MAILOXEXC
H3

EXCH2:MAILBOXEXCH2:
MAILOXEXCH4:1h:20m:10m

EXCH2:MAILBOXEXCH2,:MAILOXEXC
H4
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For example:

After completing the advanced configuration steps, you can assign and distribute policies from 
any of the various EXSPI policy groups to the managed node(s) running Microsoft Exchange 
Server. 

The EXSPI Advanced/Specialized policy groups contain two logfile policies which capture 
Exchange warning and information events. Because Exchange generates numerous warning 
and information events, you might want to assign these policies only for troubleshooting 
Exchange: 

— Logfile EXSPI-6X/55 Exchange Information

— Logfile EXSPI-6X/55 Exchange Warnings

EXCH3:MSXSPIEXCH3:EXCH4.AM.HP.COM
:
MSXSPIEXCH4:25m:5m:5m

EXCH3:MSXSPIEXCH3,EXCH4.AM.HP.C
OM:
MSXSPIEXCH4

ConditionName & 
Type

Condition Object 
Pattern

Threshol
d Explanation

EXSPI-60 1002.1
+Message on 
Matched Condition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH2

120 Threshold condition for 
ping between System 
EXCH1 and mailbox 
MSXSPIEXCH2 on 
system EXCH2. Object 
pattern is case 
sensitive.

EXSPI-60 1002.2
+Message on 
MatchedCondition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH3

240 Threshold condition for 
ping between System 
EXCH1 and mailbox 
MSXSPIEXCH3 on 
system EXCH3. Object 
pattern is case 
sensitive.

EXSPI-60 1002.3
-Suppress
Matched Condition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH2
EXCH1:MSXSPIEXCH1,
:MSXSPIEXCH3

If the threshold was not 
exceeded for these two 
system pairs, you must 
suppress the message if 
either of these system 
pairs gets past 1002.1 
or 1002.2.

EXSPI-60 1002.4
+Message on
Matched Condition

60 A blank object pattern 
to catch all remaining 
system pairs.
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Removing the Exchange SPI

This process completely removes the Exchange SPI installation from the OVO management 
server. Any customized policies or copies of Exchange SPI default policies residing in other 
OVO policy groups should also be removed. 

Follow these steps in order to ensure a proper removal of the Exchange SPI:

1. Remove Exchange SPI software from the management server

1 Use the swremove program to remove the Exchange SPI package 

a Open a terminal window and log on as root.

b In the terminal window run swremove by entering:

 /usr/sbin/swremove SPI-EXCHANGE-OVO

2 Delete the following components manually:

a Remove the EXSPI Admin group from the Application bank (see steps 9-12 in 4. 
Delete Policies, Applications and Message Groups from the Management Server on 
page 66).

b Remove EXSPI, EX_Perf and EX_Fault message groups from the OVO Message group 
bank (see step 5 in 4. Delete Policies, Applications and Message Groups from the 
Management Server on page 66).

c Delete EXSPI policies (see steps 1-4 in 4. Delete Policies, Applications and Message 
Groups from the Management Server on page 66). 

d Delete EXSPI spec files (see 5. Delete Exchange SPI Spec Files from the Management 
Server on page 67).

2. De-assign Exchange SPI Policies from Managed Nodes

After successfully removing the Exchange SPI from the management server using 
swremove, follow these steps to remove Exchange SPI policies from your managed nodes:

1 Open the OVO Node Bank.

2 To de-assign the policies from the node, select Actions>Agents>Assign Templates 
from the menu bar.

3 In the Define Configuration window select all Exchange SPI policies or policy groups, 
including any user-customized policies.

4 Click Remove Templates.

5 Click OK.

If you are upgrading from an earlier version of Exchange SPI, you must remove the old 
version from the management server and the managed nodes before installing the new 
Exchange SPI version.

The swremove program removes the files from the file system only. The components listed 
below must be deleted manually:
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3. Remove Exchange SPI from Managed Nodes

After successfully removing the Exchange SPI from the management server using 
swremove, follow these steps to remove the Exchange SPI software from your managed 
nodes:

1 Select Actions: Agents>Install/Update SW & Config from the menu bar.

2 Check the following checkboxes to select these components for removal:

• Policies

• Actions

• Monitors

• Commands

3 Click the Nodes in List Requiring Update button.

4 If you did not select a node previously, click the Get Map Selections button to list the 
target node(s).

5 Click the Force Update button.

6 Click OK. The following message appears in the message browser:

The following configuration information was successfully distributed:

Templates Actions Commands Monitors

The Exchange SPI policies and software have now been removed from the selected managed 
node(s). The Exchange SPI policies still reside in the OVO data repository and must be 
deleted manually. Continue with 4. Delete Policies, Applications and Message Groups from 
the Management Server on page 66.

4. Delete Policies, Applications and Message Groups from the Management Server

After successful completion of swremove, Exchange SPI policies and certain applications 
(EXSPI admin group) and message groups (EXSPI EX_Perf and EX_Fault), must be 
deleted manually. 

1 To delete the Exchange SPI Message Source policies, select Window: Message Source 
Templates from the menu bar.

2 Open all Exchange SPI policy groups and use SHIFT+click to select all policies for 
deletion.

3 Select Delete from All to delete the policies.

4 Click Yes to the message: Do you really want to delete the template(s)?

5 To delete from the EXSPI messages group, from the menu bar select Window>Message 
Group Bank.

6 Select the EXSPI EX_Perf and EX_Fault message groups.

7 From the menu bar select Actions>Message Group>Delete.

8 Click Yes to the message: Do you really want to delete the message groups? 

9 To delete any Exchange SPI application groups and their contents, select Window: 
Application Bank from the menu bar.

10 Select all Exchange EXSPI Admin Applications and Graphs.
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11 From the menu bar select Action>Application>Delete.

12 Click Yes to the message: Do you really want to delete the application 
groups.

5. Delete Exchange SPI Spec Files from the Management Server

Remove regular and compressed EXSPI spec files (EXSPI*.spec, EXSPI*.spec.Z) from the 
following directories on the management server: 

For DCE:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/intel/nt/cmds/ 

For HTTPS:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/x86/ winnt/cmds/ 
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4 Using Exchange SPI
Introduction

Like all HP OpenView SMART Plug-Ins, the Exchange SPI is easy to use. This chapter 
describes some special usage features and functionality, including:

• Daily Tasks

• Exchange SPI policy group requirements

• Exchange SPI Service Discovery

• Using Exchange SPI Service Views

• Data Collection Policies for Exchange 2003 and 2000 Messaging Ports

• Changing the OpenView data collection agent setup

• Command Line Parameters
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Daily Tasks

A suggested daily task list for monitoring your Exchange environment with the Exchange 
SPI:

1 Use the OVO message browser to watch for warning and critical messages or multiple 
alarms. Read the associated instruction text.

2 Adjust alarm thresholds if too many alarms are being generated (see Customizing the 
Threshold on page 100).

3 Use the OVO graphing and reporting applications for additional information, or to view 
history or see trends.

4 Check the active Message Browser frequently. Note the message group a metric belongs 
to:

• EXSPI. Messages generated by EX-SPI programs.They contain instruction text to 
help to diagnose/remedy problems.

• EX_Perf. Messages regarding performance.

• EX_Fault. Messages regarding error conditions.

5 Click Perform Action (if available) from the message or message browser to 
automatically perform a pre-defined operator action. Click Details from the message or 
message browser to view details of the set action.

6 Click Instructions from the message browser or the message itself to read and follow 
suggested instructions to help diagnose/remedy problems (see example below).

Figure 35 Sample Instruction Text from Exchange SPI Alarm Message

7 Use MeasureWare Agent to export data if desired. Consult the MeasureWare Agent User’s 
Guide for details.
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Exspi Policy Group Requirements

Some policies in the SPI for Exchange policy groups require that particular software 
components/services are installed on Exchange server systems before the distributed policies 
will work, and some require the existence of a service account with special Exchange 
privileges. To create such an account, see Creating a Service Account with Proper Access 
Permissions on page 25.

Policies requiring a service account with special Exchange privileges

The following list contains all the policies requiring this special service account, by Exchange 
version:

EXSPI Exchange 55

EXSPI-55-Dc-Exchange Info

EXSPI-55-Dc-Mailbox Data

EXSPI-55-Dc-Mailbox IS Sum Data

EXSPI-55-Dc-Public Folder Data

EXSPI-55-Dc-Public IS Sum Data

EXSPI-55-Dc-Tracklog Data

EXSPI-55-End to End Message Ping

EXSPI Exchange 2000

EXSPI-6X Dc-Transaction Log Space Usage

EXSPI-6X Transaction Log Backup Check

EXSPI-6X 1h-Public Folder Space Usage

EXSPI-6X Dc-IS Public Folder Performance

EXSPI-6X-Dc-Public IS Sum Data

EXSPI-6X-Dc-Public Folder Data

EXSPI-6X-Dc-Mailbox Data

EXSPI-6X-Dc-Mailbox IS Sum Data

EXSPI-6X-Dc-IS Mailbox Performance

EXSPI-6X-1h-Mailbox Space Usage

EXSPI-6X Dc-Full Text Index

EXSPI-6X-15m-300001

EXSPI-6X-Dc SMTP Queues

EXSPI-6X-Dc SMTP Virtual Server Storage

EXSPI-6X-Dc SMTP Server Performance

EXSPI-6X SMTP NDR Percentage

EXSPI-6X SMTP Outbound Connections Refused

EXSPI-6X MTA Message Delay
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EXSPI-6X MTA Rejected Inbound Associations

EXSPI-6X MTA Rejected Inbound Messages

EXSPI-6X MTA Work Queue Length

EXSPI-6X MTA Failed Outbound Associations

EXSPI-6X MTA Failed Conversions

EXSPI-6X Dc-X400 Service MTA Queue

EXSPI-6X Dc-TrackLog Data

EXSPI-60-Dc-InstMsg Enabled Usrs

EXSPI-6X End to End Message Ping

EXSPI Exchange 2003 

EXSPI-6X Dc-Transaction Log Space Usage

EXSPI-6X Transaction Log Backup Check

EXSPI-6X 1h-Public Folder Space Usage

EXSPI-6X Dc-IS Public Folder Performance

EXSPI-6X-Dc-Public IS Sum Data

 EXSPI-6X-Dc-Public Folder Data

EXSPI-6X-Dc-Mailbox Data

EXSPI-6X-Dc-Mailbox IS Sum Data

EXSPI-6X-Dc-IS Mailbox Performance

EXSPI-6X-1h-Mailbox Space Usage

EXSPI-6X Dc-Full Text Index

EXSPI-6X-15m-300001

EXSPI-6X-Dc SMTP Queues

EXSPI-6X-Dc SMTP Virtual Server Storage

EXSPI-6X-Dc SMTP Server Performance

EXSPI-6X SMTP NDR Percentage

EXSPI-6X SMTP Outbound Connections Refused

EXSPI-6X MTA Message Delay

EXSPI-6X MTA Rejected Inbound Associations

EXSPI-6X MTA Rejected Inbound Messages

EXSPI-6X MTA Work Queue Length

EXSPI-6X MTA Failed Outbound Association

EXSPI-6X MTA Failed Conversions

EXSPI-6X Dc-X400 Service MTA Queue

EXSPI-6X Dc-TrackLog Data

EXSPI-65-ISClientRPCFailRate

EXSPI-6X-Dc-OWA Back End
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EXSPI-6X-Dc-OWA Front End

EXSPI-6X-Dc-POP3 Performance

EXSPI-6X-POP3FailedConnRate

EXSPI-6X-POP3RejectedConnRate

EXSPI-6X-Dc-IMAP4 Performance

EXSPI-6X-IMAP4FailedConnRate

EXSPI-6X-IMAP4RejectedConnRate

EXSPI-6X End to End Message Ping

Table 1 EXSPI Schedule Policy Prerequisites for Exchange 5.5  
EXCHANGE 5.5 Policy Group Required Manual Configuration

EXSPI-55 Advanced

EXSPI End to End Message Ping
This policy requires the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.
In addition:

 - Edit the MBOX Config Application to contain User Password

- Create mailbox using MBOX Config application

- Configure EXSPI End to End Message Ping policy to set up server 
pairs

EXSPI Reporter Collection Create MSXSPI service account and password
Using Exchange SPI 73



Table 2 Schedule Policy Prerequisites in Exchange 2000 policy Groups
Exchange 2000policy Groups Required Manual Configuration

EXSPI Standard Groups

EXSPI INFORMATION STORE (Ex2000)
EXSPI Transaction Log
 EXSPI-6X Dc-Transaction Log Space Usage                                                                                     
EXSPI-6X Transaction Log Backup Check
EXSPI Public Folder (Ex2000)
EXSPI-6X 1h-Public Folder Space Usage   
EXSPI-6X Dc-IS Public Folder Performance     
EXSPI-6X-Dc-Public IS Sum Data  
EXSPI-6X-Dc-Public Folder Data
EXSPI Mailbox (Ex2000)
EXSPI-6X-Dc-Mailbox Data
EXSPI-6X-Dc-Mailbox IS Sum Data 
EXSPI-6X-Dc-IS Mailbox Performance   
EXSPI-6X-1h-Mailbox Space Usage
EXSPI Full Text Index
EXSPI-6X Dc-Full Text Index

These policies require the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.

EXSPI MESSAGING
EXSPI SMTP
EXSPI-6X-15m-300001
EXSPI-6X-Dc SMTP Queues
EXSPI-6X-Dc SMTP Virtual Server Storage
EXSPI-6X-Dc SMTP Server Performance
EXSPI-6X SMTP NDR Percentage
EXSPI-6X SMTP Outbound Connections Refused
EXSPI MTA
EXSPI-6X MTA Message Delay
EXSPI-6X MTA Rejected Inbound Associations
EXSPI-6X MTA Rejected Inbound Messages
EXSPI-6X MTA Work Queue Length
EXSPI-6X MTA Failed Outbound Associations
EXSPI-6X MTA Failed Conversions
EXSPI-6X Dc-X400 Service MTA Queue
EXSPI Tracking Log
EXSPI-6X Dc-TrackLog Data

These policies require the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.

EXSPI OPTIONAL SERVICES
EXSPI Instant Messaging
EXSPI-60-Dc-InstMsg Enabled Usrs

These policies require the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.)
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Table 3 Schedule Policy Prerequisites in Exchange 2003 Policy Groups

EXSPI Specialized Groups

EXSPI Exchange Server
     EXSPI Message Delivery
           EXSPI-6X End to End Message Ping

This policy requires the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.
In addition:

 - Edit the MBOX Config Application to contain User Password

- Create mailbox using MBOX Config application

- Configure EXSPI End to End Message Ping policy to set up server 
pairs

Exchange 2000policy Groups Required Manual Configuration

Exchange 2003 Policy Groups Required Manual Configuration

EXSPI Standard Groups

EXSPI INFORMATION STORE (Ex2003)
EXSPI Transaction Log
    EXSPI-6X Dc-Transaction Log Space Usage                                                                                     
EXSPI-6X Transaction Log Backup Check
EXSPI Public Folder (Ex2003)
EXSPI-6X 1h-Public Folder Space Usage   
EXSPI-6X Dc-IS Public Folder Performance     
EXSPI-6X-Dc-Public IS Sum Data  
EXSPI-6X-Dc-Public Folder Data
EXSPI Mailbox (Ex2003)
EXSPI-6X-Dc-Mailbox Data
EXSPI-6X-Dc-Mailbox IS Sum Data 
EXSPI-6X-Dc-IS Mailbox Performance   
EXSPI-6X-1h-Mailbox Space Usage
EXSPI Full Text Index
EXSPI-6X Dc-Full Text Index

These policies require the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.
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EXSPI MESSAGING
EXSPI SMTP
EXSPI-6X-15m-300001
EXSPI-6X-Dc SMTP Queues
EXSPI-6X-Dc SMTP Virtual Server Storage
EXSPI-6X-Dc SMTP Server Performance
EXSPI-6X SMTP NDR Percentage
EXSPI-6X SMTP Outbound Connections Refused
EXSPI MTA
EXSPI-6X MTA Message Delay
EXSPI-6X MTA Rejected Inbound Associations
EXSPI-6X MTA Rejected Inbound Messages
EXSPI-6X MTA Work Queue Length
EXSPI-6X MTA Failed Outbound Associations
EXSPI-6X MTA Failed Conversions
EXSPI-6X Dc-X400 Service MTA Queue
EXSPI Tracking Log
EXSPI-6X Dc-TrackLog Data

These policies require the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.

EXSPI CLIENT ACCESS
EXSPI Outlook 2003
EXSPI-65-ISClientRPCFailRate
EXSPI OWA
EXSPI Back End:
EXSPI-6X-Dc-OWA Back End
EXSPI Front End:
EXSPI-6X-Dc-OWA Front End
EXSPI POP3
EXSPI-6X-Dc-POP3 Performance
EXSPI-6X-POP3FailedConnRate
EXSPI-6X-POP3RejectedConnRate
EXSPI IMAP4
EXSPI-6X-Dc-IMAP4 Performance
EXSPI-6X-IMAP4FailedConnRate
EXSPI-6X-IMAP4RejectedConnRate

These policies require the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.

Exchange 2003 Policy Groups Required Manual Configuration
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EXSPI Specialized Groups

EXSPI Exchange Server
     EXSPI Message Delivery
          EXSPI-6X End to End Message Ping

This policy requires the completion of tasks 1-3 of the 
Configuring the Exchange SPI on page 46.
In addition:

 - Edit the MBOX Config Application to contain User Password

- Create mailbox using MBOX Config application

- Configure EXSPI End to End Message Ping  policy to set up server 
pairs

Exchange 2003 Policy Groups Required Manual Configuration
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Exchange SPI Service Discovery

The Exchange SPI contains a scheduled data collection policy to discover Exchange services 
on OVO managed nodes and the EXSPI-6x Exchange Cluster Discovery SysLog and EXSPI-6x 
Exchange Cluster Discovery for discovering Exchange in cluster environments. The discovery 
process can be initiated at any time by running the policies on the OVO management server. 
Out-of-the-box the policies are set to run once a day at 00:24 am in the morning, to discover 
Exchange services.

The service graph generated by the Discovery policies is a snapshot of the services on the 
managed nodes at the time at which the policy is run. The discovered Exchange topology is 
maintained in OVO and is made available in the various dynamic Exchange maps and views.

The views of discovered services enable operators to see at a glance the current operational 
status of their Exchange environment, and can help them to analyze events in terms of their 
impact on the overall business service.

Prerequisites for Exchange SPI Service Discovery

• The Service Discovery Component for HP OpenView SPIs(HPUX) (SPI-SVCDISC-OVO, 
A.02.00 and above) should be installed on the management server.

• Exchange SPI service discovery requires that Windows Scripting Host version 5.6 is 
present on the managed node. By default, this version is present in Windows 2000/2003. 
Windows NT users should install the WSH version 5.6 manually, before running 
Exchange SPI discovery.

• Exchange SPI service discovery requires the OVO Service Navigator, this can be installed 
together with other OVO components at initial OVO installation. For details on how to 
install it at a later date, refer to the OVO Installation Guide.

• The machine where the OVO management server is installed should also be a managed 
node of that management server, with the OpenView Operations agent software installed 
and running successfully.

• It is necessary to create a privileged user with the name “msxspi” on the domain 
controller of the domain to which each managed Exchange server belongs, and to make 
this user account a member of  the “Administrators”, “Domain Admins”, “Domain Users”, 
and  “Exchange Domain Servers” groups.

• For each managed node where Exchange Service Discovery should run, make sure that 
the EXSPI Node Config tool is run, using the “msxspi” user account details. Running this 
tool will write and encrypt the local.cfg file with the username and password 
information of the privileged user account [msxspi] on the managed node.

Mechanism for Gathering Service Information

The mechanism the Exchange SPI uses to gather service information is a simple one: a 
discovery server on the OVO management server uses the list of managed nodes as 
parameters to trigger a discovery client on each of the OVO managed nodes listed. The 
discovery clients on the various OVO managed nodes use discovery modules that are installed 
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during the installation of the Exchange SPI agent software, to gather information about the 
services present on the managed nodes. The discovery server writes error messages to the 
following file:

/var/opt/OV/log/SPISvcDisc/discovery_error.log

Tracing can be enabled on the Management server by turning ‘ON’ the SPI_DISC_TRACE 
variable in the EXSPI_DiscConfig.sh file which is found under:

/opt/OV/EXSPI/bin/

The trace file (discovery_trace_EXSPI.log) can be found on the management server 
from the following location:

/var/opt/OV/log/SPISvcDisc/

The discovery client on the managed node writes generic error information into:

%OvAgentDir%\log\SPISvcDisc\discovery.log

Apart from these files, EXSPI discovery errors can also be found in EXSPI error log file:

%OvAgentDir%\exspi\log\exspierror.

If tracing is enabled, any tracing information can be found in:

%OvAgentDir%\exspi\log\trace

The service configuration files compiled by the discovery process are written to the directory 
on the management server using the following file-naming conventions:

/var/opt/OV/SPISvcDisc/conf/EXSPI/EXSPISvcDisc_<nodename>.xml

where nodename is the name of the node on which discovery has run.

The discovery server validates the syntax of the Service configuration file. If the file is valid, 
discovery server activates the service file and assigns operators to the Root service EXSPI. By 
default, the operator, opc_adm will be assigned. The activated services can be viewed through 
Java GUI of OVO/Unix, when logged in as 'opc_adm'.

Turning off Discovery failure messages:

When Exchange SPI Discovery fails to discover services, failure messages are sent to the OVO 
Management server. To turn off these messages, the user has to modify the file 
EXSPI_DiscConfig.sh located in /opt/OV/EXSPI/bin on the Management server. 

The user has to change MSG_ALLOW=Y to MSG_ALLOW=N. (The default value is Y, which means 
messages are allowed).

Upon successful discovery, a message window will notify that a significant change has 
occurred in the service configuration on the management server, and it is necessary to reload 
the configuration and update the service map.

To Reload The Configuration

1 Logon to the OVO Java console as the OVO Administrator opc_adm.

2 Select File-> Reload Configuration.

3 A window will notify that the reload configuration is in progress.

4 View the updated service maps.
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Manual Update

Changes to the service configuration of a managed node do not appear automatically in the 
SPI for Exchange Server service tree. In order to update the contents in the OV Service 
Navigator, the Discovery policies have to be run.

Figure 36 Service Tree View of Service Map
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Using Exchange SPI Service Views

The Exchange SPI integrates with the OpenView Service Navigator to provide an additional 
perspective on the Exchange organization by offering Service views. This feature is available 
only if the OpenView Service Navigator software is installed and running and allows 
individual systems to be seen in terms of the configured hardware, the installed software, and 
the operating system services that are running.

Exchange SPI discovers Exchange services when the Exchange SPI discovery policies are run, 
and uses the discovered data to generate the service SPI for Exchange Server tree. Example 
service views are shown in Exchange 5.5 Service Graph chapter 4 page 101, and Exchange 
2000 and 2003 Service View chapter 4 page 103.

Figure 37 Exchange 5.5 Service Graph

Views Are Snapshots

The service graph generated by the Exchange SPI is a snapshot of the services on the 
managed nodes at the time at which the EXSPI Discovery policies are run. If the service 
configuration on a managed node subsequently changes, you have to run the discovery process 
again to have the changes reflected in the service tree.
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Calculation and Propagation Rules in Discovery Process

Propagation rules for the objects in the SPI for Exchange Server tree are defined by default as 
unchanged. This means that a parent service does not change the status of a child object by, 
for example; attaching a priority to it. Such a scenario would be feasible if a parent service 
considered the status of one child service to be more important than the status of another 
child service.

Calculation rules for the SPI for Exchange Server tree are set by default to Most Critical. 
This means that if a parent service has more than one child service, it assumes the status 
equal to the highest severity of its child services. For more information about calculation and 
propagation rules, as well as how to go about modifying them, see the HP OpenView Service 
Navigator Concepts and Configuration Guide.

Figure 38 Exchange 2000 and 2003 Service Graph

OVO messages are associated with all the low-level services and, in addition, the higher-level 
services: Exchange Information store and Exchange Messaging
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Data Collection Policies for Exchange Messaging Ports

The EXSPI_PORTS.exe examines the Exchange messaging port availability of an Exchange 
2000 or 2003 server.

Command line parameters

Usage Syntax: [-a] [-p] [-l] [-m 60, 61…metric number(s) or ranges 60-63] 

[[-x key=value] [...]]

-a: alarming with the management server console

-p: to print out data collected to stdout

-l: to log data collected to the embedded performance agent (Coda)

-m: metric number or range

 e.g. -m 1006, 1008-1009

-x key=value: to specify argument value

e.g., "-x timeout=10" is to set port connection timeout to be 10 seconds.

Default value for Timeout Interval = 5 seconds.

Metric Id's for Ports:

• SMTP 1006

• POP3 1007 

• IMAP4 1008

• HTTP 1009

Message sent to management server console

The <SMTP/POP3/IMAP4/HTTP (whichever is applicable)> protocol (<1006/1007/1008/
1009(respectively)>) was not available before timeout (<timeout interval> seconds).

Default values for Protocol Ports

SMTP_PORT = 25

IMAP_PORT = 143

POP3_PORT = 110

HTTP_PORT = 80

Policies calling exspi_ports.exe

Policy Name: EXSPI-6X HTTP Port Response

Description: Determines if the HTTP port is responsive.

Execution Schedule:    

MINUTE   0, 10, 20, 30, 40, 50
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HOUR     0-23

Schedule Program: exspi_ports.exe -a -l -m 1009

USER: $AGENT_USE

Failure Message Details:

SEVERITY: Warning

Message Group: EXSPI

TEXT: EXSPI-6X HTTP Port Response failed.

Policy Name: EXSPI-6X IMAP4 Port Response

Description: Determines if the IMAP4 port is responsive.

Execution Schedule:    

  MINUTE   0, 10, 20, 30, 40, 50    

  HOUR    0-23

Schedule Program: exspi_ports.exe -a -l -m 1008

USER: $AGENT_USER

Failure Message Details:

SEVERITY: Warning

Message Group: EXSPI

TEXT: EXSPI-6X IMAP4 Port Response failed.

Policy Name: EXSPI-6X POP3 Port Response

Description: Determines if the POP3 port is responsive.

Execution Schedule:    

MINUTE   0, 10, 20, 30, 40, 50

HOUR     0-23

Schedule Program:  exspi_ports.exe -a -l -m 1007

USER: $AGENT_USER

Failure Message Details:

SEVERITY: Warning

Message Group Name: EXSPI

Message Text: EXSPI-6X POP3 Port Response failed.

Policy Name: EXSPI-6X SMTP Port Response

Description: Collects SMTP queue metrics

Execution Schedule:    

MINUTE   1, 11, 21, 31, 41, 51

HOUR     0-23
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Schedule Program:   exspi_ports.exe -a -l -m 1006

USER: $AGENT_USER

Failure Message Details:

SEVERITY: Warning.

Message Group Name: EXSPI

Message Text: EXSPI-6X SMTP Port Response failed.

Port settings:

First the Exspi_ports binary checks the port entry in 
C:\WINDOWS\system32\drivers\etc\services. If the search fails, the binary takes the 
default entries for the ports from the code.

/***************************************************************

Protocol ports

***************************************************************/

SMTP_PORT                     = 25;

IMAP_PORT                     = 143;

POP3_PORT                     = 110;

HTTP_PORT                     = 80; 

If the SSL inclusion changes the port number you must change the port number in the 
services file to the new one manually, then Exspi_port takes this modified port number. 
Exspi_port binary does not modify the services file by passing any parameter.
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Changing the Data Collection Agent Setup

The HP OpenView Exchange SPI can detect whether or not you are using OpenView 
Performance Agent (also known as MeasureWare Agent). If you are, your new Exchange SPI 
installation will automatically use it as well. As a result, if you use PerfView, your new 
installation also supports that configuration. 

If you decide to use the new HP OpenView subagent included with OVO 7.0 or 8.0, you can 
configure managed nodes to do so. Note that this configuration does not support PerfView. 

To override the use of HP OpenView Performance Agent:

• For CODA, change the command parameters to be -a-Coda EXSPI_*.spec and 
launch the application EXSPI Add DataSource on the target managed node.

• For MWA, change the command parameters to be -a-MWA EXSPI_*.spec and launch 
the EXSPI Add DataSource application on the target managed node.
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Command Line Parameters

The collector/analyzer executable exspi_e2k.exe can be used with the following command 
line parameters:

Parameter Description

-m <metric range> -m (metric range) is used to specify the metric 
number or range of metric numbers.

-t <tag> -t (tag) allows the collector/analyzer to use a 
different set of policies than those originally 
provided with the Exchange SPI when collecting 
metrics.
NOTE: Additional information about the tag 
feature is found at the end of the “Customizing 
Exchange SPI” section.

-p -m <range> [-v] -p (print) executes specified metrics and prints their 
values to standard output, for example:
<exspi_e2k.exe or exspi_e55.exe> -p -m 1-1001

-a -a directs the collector/analyzer to send the metric 
value to OVO for alarm generating

-s -s executes the collector as the special service 
account user (MSXSPI). Requires completion of the 
advanced configuration (see Configuring the 
Exchange SPI on page 46).

-l -m <metric range> 
-x <extended_option> 

Data collection metrics start at 0500. Types:
Value: logs the actual value
Delta: logs the difference between current and 
previous
Average: logs the average over a specific interval 
(e.g. 1h)
where:
-l collector logs data to logfile instead of reporting it 
to OVO
-x <extended_option> is one of: 
 logtype: is either "value, delta, or avg"
 logfreq: can only be "hourly" and is used only  
with "avg"
 runfreq: tells the collector the interval in seconds. 
If the schedule interval of EXSPI is every 10 
minutes, the runfreq option must be set to 10*60 = 
600: -x runfreq=600. The runfreq option can only be 
used with "avg."
 mbox: followed by "=<mailbox_name>" allows 
specification of certain mailboxes with certain 
metrics, specifically metrics:
611,612,622,623,630,631,632,640 and 641 
Example of a command line using this option:  
exspi -p -m 611 -x mbox=obrab
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5 Clustering Support
Using Exchange SPI in high availability environments

The Exchange SPI can be configured to accommodate cluster environments where fail-overs 
allow uninterrupted Exchange availability. 

Synchronized with the cluster environment, Exchange SPI monitoring can be made to switch 
off for the failed node and switch on for the active node. 

For recognizing clustered Exchange instances, Exchange SPI relies on XML configuration 
files. These files allow the OVO agent to automatically enable instance monitoring on the 
currently active node after disabling instance monitoring on the inactive node.

The Exchange SPI setup for a cluster environment requires the following steps: 

1 Add the nodes to be managed.

2 Modify, if necessary, the Exchange SPI monitoring configuration file included with the 
Exchange SPI (msexchange.apm.xml).

3 Create the clustered application configuration file (apminfo.xml) that associates 
Exchange SPI-monitored instances (Exchange virtual servers), with their corresponding 
cluster resource groups.

4 Restart the agent on the managed node.

Task 1: Add the Exchange Cluster Nodes to be Managed.

Add the Exchange cluster nodes to be managed. 

Task 2: Modify the Exchange SPI Monitoring Configuration File (if necessary)

The Exchange SPI includes a monitoring configuration file, (msexchange.apm.xml), which is 
an XML file that describes the policies that should be cluster-aware.

The (msexchange.apm.xml file works in conjunction with the clustered application 
configuration file (apminfo.xml) that you need to create for your Exchange cluster.

The purpose of the Exchange SPI msexchange.apm.xml file is to list all the Exchange SPI 
policies on the managed node, in order that these policies can be disabled/enabled, as 
appropriate, for inactive/active managed nodes. 

The Exchange SPI msexchange.apm.xml file is normally ready to use with no configuring. 
However, if you have renamed any policies, you need to modify the file accordingly. The file is 
in the monitor directory on the management server. After modifying this file, you need to 
redistribute the monitors to the Exchange nodes that are part of the Exchange cluster.
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Task 3: Create the Cluster Application Configuration File

Apminfo.xml is an XML file that describes the cluster instances (Exchange virtual servers).

Apminfo.xml, working in conjunction with the Exchange SPI monitoring configuration file 
(msexchange.apm.xml), allows you to associate Exchange SPI monitored instances 
(Exchange virtual servers) with their associating cluster resource groups. As a result, when a 
resource group is moved from one node in a cluster to another node in the same cluster, 
monitoring stops on the failed node and starts on the new node.

To generate the content of this file:

1 Launch the Exchange SPI Exchange Cluster Configuration application on an Exchange 
cluster node, see Exchange Cluster Configuration application on page 91.   

2 Save the generated output in a temporary file by clicking on the Save. button.

3 Open this temporary file and remove all the lines above: 

<?xml version="1.0" ?>

4 Save the remaining lines as the completed apminfo.xml file. 

• If the node is managed under OVO 7 and OVO 8 / DCE, save it to:

%OvAgentDir%\conf\OpC

• If the node is managed under OVO 8 / HTTPS.save it to:

<OVO_DATADIR>\conf\conf

Task 4: Restart the agent on the managed node

After constructing and saving apminfo.xml, stop and restart the OVO agent by running the 
following commands on each node: 

opcagt -kill
opcagt -start 

If the Exchange Cluster is managed under OVO 8 / HTTPS then msexchange.apm.xml 
needs to be manually copied from:

$OvDataDir\bin\instrumentation

to

$OvDataDir\bin\instrumentation\conf

for each managed node.

You can get the full path name for OVO_DATADIR by running the following command from a 
CMD window on the managed node: 

opcagt -type -verbose
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Example apminfo.xml file

The following is an example apminfo.xml file, where ExchResGroup1 and 
ExchResGroup2 are the names of the Exchange resource groups corresponding to 
EXCHVIRTSERV1 and EXCHVIRTSERV2 instances (virtual servers):

<?xml version="1.0" ?>
<APMClusterConfiguration>
  <Application>
    <Name>msexchange</Name>
      <Instance>
         <Name>EXCHVIRTSERV1</Name>
         <Package>ExchResGroup1</Package>
       </Instance>

<Instance>

<Name>EXCHVIRTSERV2</Name>
         <Package>ExchResGroup2</Package>
       </Instance>

  </Application>
</APMClusterConfiguration> 

Figure 39 Example Exchange resource group   

Exchange Cluster Configuration application

Use the Exchange Cluster Configuration application to generate the content of the 
apminfo.xml file. To execute this application:

1 Select all the Exchange managed nodes you wish to configure in the OVO Node Bank.

2 Drag these nodes and drop them on the Exchange Cluster Config application located in 
one of  the following application groups:

— EXSPI Admin > Exchange 2007 application group if you are using Exchange 
2007 nodes.
Clustering Support 91



— EXSPI Admin > Exchange 2000 and 2003 application group if you are using 
Exchange 2003 or 2000 nodes.

3 Use the generated output to construct the apminfo.xml. For details, refer to 
Create the Cluster Application Configuration File on page 90).

Figure 40 Example output of Cluster Configuration application

Data Collection on virtual servers

In order for reports and graphs to show data for any nodes, appropriate data collection policies 
need to be distributed to those nodes. See the section Using Exchange 5.5 Reports and Graphs 
on page 119.

Run the Enable Message Tracking application on all nodes in the cluster before 
distributing the EXSPI 6.X Dc-TrackingLog Data policy, so that the tracking log reports 
will generate. The application must run on the physical nodes of a cluster where the Exchange 
virtual server is running.

After constructing and saving apminfo.xml, you need to restart the agent on the node, using 
the following commands:

Opcagt -stop

Opcagt -start
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Seeing virtual servers in reports and graphs

The Exchange SPI will show Exchange virtual servers in reports and graphs as though they 
were physical Exchange servers.

Setting up End-to-End Message Ping on an Exchange Cluster

Using Exchange SPI, End-to-End Message Ping can be configured on Exchange clusters. 

1 Run the EXSPI MBox Config application on all nodes in the cluster. The application 
must run on the physical nodes of a cluster where the Exchange virtual server is running 
on. This is a necessary step for configuring and distributing End-to-End Message Ping. 

2 Follow the directions in Set Up Message Ping Server Connections and Alarms on page 59.

Exchange Cluster Service Map

Exchange clusters are represented in the Service Map, and Service map nodes are created in 
the service map for each Exchange virtual server in a cluster. 

Messages for the Exchange virtual server show up under the Exchange virtual server name in 
the maps.

For the Exchange Virtual server an EXSPI service discovery hosted-on hierarchy is created 
within a Clusters container, which allows messages to be sent to the hosted-on hierarchy. This 
same hierarchy is also created as virtual nodes under the Exchange Virtual Server. 

A dependency is created from each Virtual Exchange Server virtual node to its corresponding 
Cluster hosted-on node. Messages and status will then propagate up to the correct Virtual 
Exchange Server virtual node.
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Figure 41 Service Graph of Clustered Nodes

What happens during a failover:

When a failover happens, dependencies to the failed node will be removed and replaced with 
new dependencies to the newly active node. For example, if EXCHVIRTSERV1 moves from 
OVRNTTC1B to OVRNTTC1A, the dependencies to OVRNTTC1B will automatically be 
removed and will be replaced with a new set of dependencies to OVRNTTC1A.

When a failover happens, messages that occurred before the failover will not be propagated to 
the virtual node

For this mechanism to work  EXSPI-6x Exchange Cluster Discovery SysLog and EXSPI-6x 
Exchange Cluster Discovery policies must be distributed
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6 Customizations
Introduction

This chapter outlines the following customization procedures:

1 Choosing metrics to monitor Exchange

2 Customizing the Exchange SPI

a Basic Customization procedures

— Creating custom groupings

— Creating custom policies

— Modifying message generation

— Modifying metric policy conditions

— Customizing the Threshold

— Customizing Schedules

— The Tag Feature

b Advanced Customization procedures

— Changing the Windows User Account Name

— Changing the Mailbox Name

3 Returning to original factory settings
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Choosing metrics to monitor Exchange

Before beginning customization, first decide which metrics can remain without changing the 
thresholds, (see “Exchange SPI Metric Specifications” later in this chapter or the Exchange 
SPI Reference Manual).

It is recommended that you make a copy of the original policy group and use the copy 
for customization purposes
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Basic Customization 

Creating Custom Groupings

Create custom policy groups as follows:

1 Log onto OVO as the OVO Administrator.

2 Select Window>Message Source Templates.

3 In the Message Source policies window select the desired policy group and click the 
Add... button (if Add Logfile... is displayed, pull down the list and select Add Group) and 
select a name and description for this group.

4 To copy policies to the new group:

• In the Message Source policies window, double-click to open the group containing the 
desired policies.

• Select the policies to copy and choose Edit>Copy from the Message Source 
Templates menu to copy the policies.

• Return to the newly created policy group and choose Edit>Paste from the menu.

Figure 42 Creating a New Policy Group

Creating Custom Policies

You can create a custom policy by copying an original policy, making any desired changes, and 
saving it with a new name.

When the OVO environment scales, the Exchange SPI tag feature provides a way to partition 
policies into groups with each group customized in a specific manner. 

Modifying Message Generation 

Alarms are generated with Reset, without Reset or Continuously. To change the 
Metric Generation Type (usually in conjunction with the Threshold, Polling 
Interval and Reset value) follow these steps:

1 Select the Message Source Templates window.

2 Double-click to open the policy group containing the metric to modify.

3 Click the Modify button. 
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Figure 43 Modifying Message Generation

4 Select one of the Message Generation types:

— with Reset: Alarms are generated after the monitoring threshold has been 
exceeded. No additional alarms are generated until metrics drop below a specified 
Reset threshold and subsequently exceed the monitoring threshold.

— without Reset: Alarms are generated after the monitoring threshold has been 
exceeded. No additional alarms are generated until metrics drop below the 
threshold and subsequently exceed it.

— Continuous: Alarms are generated continuously when metrics exceed the 
threshold.
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Modifying Metric Policy Conditions

Modify metric attributes as follows.

1 Select the Message Source Templates window.

2 Double-click the policy group containing the metric to modify.

3 Double-click the desired metric

4 In the Message and Suppress Conditions window select the condition to modify and click 
the Modify button.

Figure 44 The Message and Suppress Conditions Window

5 The Condition window displays.

The following attributes can be easily modified:

Threshold. Set the desired threshold.

Reset. This is a limit under which the object's value must drop (or exceed for 
minimum thresholds) to return the alarm state of the object to normal. After an 
object's alarm state has returned to normal, a new message can be issued if the 
monitored parameter again exceeds (or drops below for minimum thresholds) the 
threshold value. Do not enter a value if you do not wish to impose a reset limit. Note 
that you can enter a reset value greater than the threshold value (or less for minimum 
threshold types), which has the same effect as if you don't specify a reset value.
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Duration. Most metrics are defined as Message Generate type without Reset 
and without a Duration. Please consult the OVO Concepts Guide or online Help prior 
to modifying this field.

Severity. Click the [Severity] button and select the desired severity setting.

Message Text. Be careful not to modify any of the parameters in a message. 
Parameters are surrounded by <> brackets and begin with $.

Actions. This field provides the ability to add custom programs. Two types of actions 
are available: 

Operator initiated: These actions are only performed upon the initiation of an 
operator.

Automatic: These actions are performed automatically when the metric alarms.

Customizing the Threshold

Customize the threshold as needed. To do so, copy the existing condition to use as the default, 
and modify the original condition to serve as the exception. Follow these steps:

1 Double-click the metric you want to customize (for example, EXSPI-60-0001). 

2 In the Message and Suppress Conditions window select the desired condition and select 
the Copy button to make a copy of the condition. 

3 Enter a name for the condition; for example, EXSPI-6X-0001.3.

4 Click OK to close EXSPI-6X-0001.3. This will be the default condition.

5 Select the original condition, EXSPI-6X-0001.1.

6 Click the Modify button to display the Condition window.

7 In the Object Pattern field, enter the desired characters to use for pattern matching 
(see the OVO online help or the OVO Administrators Task Guide for pattern matching 
syntax).

8 Click the Test Pattern Matching… button to test the pattern and verify pattern 
matching (you must set up a match file first).

9 Change the value in the value in the Threshold field.

Figure 45 Testing Pattern Matching from the Condition Window

Some metrics have an operator-initiated action which will display a graph if 
PerfView is installed on the management server.
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Customizing Schedules

Schedule policies define the schedule by which the collector/analyzer will gather metric 
information. To modify a schedule policy, follow these steps:

1 Select Window>Message Source Templates and double-click the policy group 
containing the policy to modify.

2 Double-click the desired policy

3 In the Modify Scheduled Actions change any of the schedule information or other 
parameters. 

4 Click OK to close and save the changes.

5 Distribute the policy to the desired managed node(s).
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Figure 46 Customizing a Schedule policy
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The Tag Feature

When servers are dedicated to specific sites or business units, you may find it more effective if 
those servers do not all share the same set of Exchange SPI policies. In such cases, the tag 
feature is useful in allowing you to change existing policies and rename them. In this way you 
can associate policy assignments with specific servers and the areas with which they are 
associated. For example, you might create a business administration group of policies and tag 
those policies with “ADM-” or a branch office group and tag those with “BR-.”

The tag feature allows you to create custom policies in a quick way. To summarize the steps, 
you:

a Make copies of existing monitor policies that you want to modify. 

b (optional) Modify the monitor policy settings. 

c Save each modified policy under the same name with a prefix.

d Enter each metric and - <prefix tag> after the collector/analyzer command in the 
Program Monitor or MIB ID box of the schedule policy.

Using this method allows the collector/analyzer to recognize a set of policies different from 
those originally provided with the Exchange SPI. This method allows you to enlarge the single 
set of policies to adjust to differing conditions among the servers you use.

To use this feature, make copies of the original Exchange SPI policies. The names you give 
these new policies must contain a prefix with the original policy name. To tell the collector/ 
analyzer to use this new policy rather than the original policy, specify the tag option on the 
schedule policy command line.

New collector policies can also be created in this way, for example:

exspi_e2k -m 16 -t ADM-

In this case the new collector policy is called "ADM-EXSPI-15min."
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Advanced Customization

Changing the Windows User Account name

A Windows user account, used for creating a mailbox, is referenced in the EXSPI MBOX 
Config application. To change the account name, edit the EXSPI Mbox Config application and 
change the user name setting. This application requires a user with Exchange administrative 
privileges.

Changing the Mailbox name

For all schedule policies in the policy group EXSPI-6X Data Collection (Adv), add -x 
<mailbox_name> to the command which is executed under the schedule. For example: 

exspi_e2k -l-s -m 630,631,632 -x logtype=value -x mbox=MSXSPI

The default mailbox MSXSPI <hostname> can be changed by supplying the mailbox name to 
EXSPI MBOX Config:

Use the OVO Customized Startup to start EXSPI MBOX Config, and add 
-m <mailbox name prefix> [-ou <organizational unit>]
to the Application Parameter box.

Do not add the domain before the user name. The user must be in the domain where 
the Exchange Server is located, and cannot be a local user.
104 Chapter 6



Returning to original factory settings

To re-install all Exchange SPI policies, applications and message groups with original factory 
settings, run the following command:

/opt/OV/bin/OpC/opccfgupld -verbose -replace /var/opt/OV/share/tmp/
OpC_appl/EXSPI/exspiset

Any customization of the original policies will be overwritten.
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7 Integration with Reporter
Introduction

This chapter describes how to install and generate reports within Reporter from Exchange 
SPI data. It contains the following sections:

• Installing Exchange SPI reports

• Exchange SPI report policy requirements

• Lists of Exchange SPI reports, by Exchange version

• Using Exchange SPI reports and graphs

– Distributing data collection policies

– Distributing Reporter Collection policies

• Exchange SPI graphs

• Deinstalling Exchange SPI Reporter policies
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Data Collection for Graphing and Reporting

Exchange SPI reports display data collected from EXSPI policies distributed to Exchange 
servers. The Exchange SPI collects data for graphing and reporting through data collection 
policies. Exchange and Windows data is collected, summarized, and forwarded to the OVO 
data collecting agent. Reporter can be used to access the data source EXSPI_DATA and write 
reports using Seagate Crystal Reports.

Data is collected through data collection policies, see the HP OpenView Smart Plug-in for 
Microsoft Exchange Server Reference Guide, for a complete listing of Schedule Data Collection 
policies for each Exchange version. 

The specific Schedule Data Collection policies that must be distributed for Exchange SPI to 
generate particular reports are as follows:

Table 4  Data Collection Policies Required for Reports
Report Name Policy Name Report Group

Exchange 2003 Active Sync Usage EXSPI-65-Dc-ActiveSync Client Access

Exchange 2003 Active Sync 
Notifications

EXSPI-65-Dc-ActiveSyncNotify Client Access

Exchange 2003 OMA Sync Usage EXSPI-65-Dc-OMA Client Access

Exchange 2003 and 2000 IMAP4 
Connections 

EXSPI-65-Dc-IMAP4 Performance Client Access

Exchange 2003 and 2000 IS Users 
and Connection

EXSPI-6X-Dc-Information Store 
Performance

Client Access

Exchange 2003 and 2000 
Messaging Ports

EXSPI-6X SMTP Port Response 
EXSPI-6X POP3 Port Response 
EXSPI-6X IMAP4 Port Response 
EXSPI-6X HTTP Port Response 

Client Access

Exchange 2003 and 2000 OWA 
Usage

EXSPI-6X-Dc-OWA Back End Client Access

Exchange 2003 and 2000 OWA 
Authentications

EXSPI-6X-Dc-OWA Back End Client Access

Exchange 2003 and 2000 OWA 
Connections

EXSPI-6X-Dc-OWA Front End Client Access

Exchange 2003 and 2000 POP3 
Connections

EXSPI-6X-Dc-POP3 Performance Client Access

Exchange 2003 and 2000 System 
Information Summary

EXSPI-6X-Dc-Mailbox IS Sum Data 
EXSPI-6X-Dc-Public IS Sum Data

Exchange Server

Exchange 2003 and 2000 Full Text 
Indexing Stats

EXSPI-6X Dc-Full Text Index Information Store

Exchange 2003 and 2000 
Transaction Log Stats

EXSPI-6X Dc-Transaction Log 
Space Usage

Information Store

Exchange 2003 and 2000 Inactive 
Mailboxes

EXSPI 6X-Dc-Mailbox Data Mailbox Store

Exchange 2003 and 2000 Mailbox 
Details

EXSPI 6X-Dc-Mailbox Data Mailbox Store

Exchange 2003 and 2000 Mailbox 
Store Stats

EXSPI-6X-Dc-Mailbox IS Sumdata Mailbox Store

Exchange 2003 and 2000 Mailbox 
Summary

EXSPI 6X-Dc-Mailbox IS Sum 
Data

Mailbox Store
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Exchange 2003 and 2000 Mailbox 
Usage Trends

EXSPI-6X Dc-Mailbox IS Sum 
Data

Mailbox Store

Exchange 2003 and 2000 Mailbox 
Store Messaging Trends

EXSPI-6X-Dc-IS Mailbox 
Performance 

Mailbox Store

Exchange 2003 and 2000 Top 100 
Mailboxes

EXSPI-6X-Dc-Mailbox Data Mailbox Store

Exchange 2003, 2000 and 5.5 
Message Delivery SLA 

EXSPI-6X End to End Message 
Ping

Messaging

Exchange 2003, 2000 and 5.5 Top 
Destinations

EXSPI-6X Dc-TrackLog Data Messaging

Exchange 2003, 2000 and 5.5 Top 
Recipients

EXSPI-6X Dc-TrackLog Data Messaging

Exchange 2003, 2000 and 5.5 Top 
Senders

EXSPI-6X Dc-TrackLog Data Messaging

Exchange 2003, 2000 and 5.5 Top 
Sources

EXSPI-6X Dc-TrackLog Data Messaging

Exchange 2003 and 2000 All Local 
Msg Delivery SLA

EXSPI-6X Dc-TrackLog SLA 
Delivery 

Messaging

Exchange 2003 and 2000 MTA Msg 
Trends

EXSPI-6X Dc-MTA Performance Messaging

Exchange 2003 and 2000 MTA 
Queue Data Stats

EXSPI-6X Dc-X400 Service MTA 
Queue 

Messaging

Exchange 2003 and 2000 Message 
Tracking Stats

EXSPI-6X-Dc-Message Tracking 
Log Space Usage 

Messaging

Exchange 2003 and 2000 SMTP 
Connections

EXSPI-6X Dc-SMTP Server 
Performance 

Messaging

Exchange 2003 and 2000 SMTP 
Msg Trends

EXSPI-6X Dc-SMTP Server 
Performance

Messaging

Exchange 2003 and 2000 Virtual 
Server Stats 

EXSPI-6X Dc-SMTP Virtual Server 
Storage

Messaging

Exchange 2003 and 2000 Exchange 
Folder Summary

EXSPI-6X-Dc-Public IS Sum Data Public Folder Store

Exchange 2003 and 2000 Exchange 
Folder Usage Trends

EXSPI-6X-Dc-IS Public Folder 
Performance

Public Folder Store

Exchange 2003 and 2000 Inactive 
Folders

EXSPI 6X-Dc-Public Folder Data Public Folder Store

Exchange 2003 and 2000 Public 
Folder Store Stats 

EXSPI-6X-Dc-Public IS Sum Data Public Folder Store

Exchange 2003 and 2000 Public 
Folder Store Msg Tnd 

EXSPI-6X-Dc-Public IS Sum Data Public Folder Store

Exchange 2003 and 2000 Top 100 
Public Folders

EXSPI-6X-Dc-Public Folder Data Public Folder Store

Report Name Policy Name Report Group
Integration with Reporter 109



Exchange SPI Reports

Installing Exchange SPI Report Policies

 To install Exchange SPI reports on the system where Reporter is installed:

1 Double-click EXSPI-Reporter.msi on the HP OpenView Operations for Unix Application 
CD-ROM. This opens the EXSPI-Reporter InstallShield Wizard.

2 Click Next on the welcoming dialog.

3 The next dialog confirms that EXSPI-Reporter is now installed, click Finish to exit the 
wizard.

4 Open Reporter to see the SPI for Exchange folder under Reports.

5 Open the SPI for Exchange group of reports, and see the groupings of Exchange reports. 
As you select each group, see in the details pane the individual reports available in that 
group.

Reports for Exchange 2007 Servers

The SPI for Microsoft Exchange Server 2007 provides the following reports:

• Exchange 2007 Mailbox Details by Server — This report contains information about 
mailboxes on the Mailbox Server. This report displays information sorted by disk space 
usage and grouped by storage group and database. The Exchange 2007 Mailbox Details by 
Server report uses the EXSPI-8X Get Mailbox Details policy and uses the following 
metrics from the data store:

— MB_SIZE 

— MB_MSGCOUNT

— MB_STGLIMIT

— MB_LASTACCESS

— MB_SGNAME

— MB_DBNAME

• Exchange 2007 Top 100 Mailboxes — This report lists the top 100 mailboxes by disk space 
usage across all Exchange 2007 Mailbox Servers. The Exchange 2007 Top 100 Mailboxes 
report uses the EXSPI-8X Get Mailbox Details policy and uses the following metrics from 
the data store:

— MB_SIZE 

— MB_MSGCOUNT

— MB_STGLIMIT

— MB_LASTACCESS

— MB_SGNAME

— MB_DBNAME
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• Exchange 2007 Inactive Mailboxes by Server — This report lists the mailboxes that were 
not used to send mails in 20, 40 and 60 or more days and the number of days for which the 
mailboxes were not used. The Exchange 2007 Inactive Mailboxes by Server report uses 
the EXSPI-8X Get Mailbox Details policy and uses the following metrics from the data 
store:

— MB_SIZE 

— MB_LASTACCESS

— MB_SGNAME

— MB_DBNAME

• Exchange 2007 Mailbox Store Message Trends by Server — This report contains 
summary and detailed  trend graphs showing Mailbox Store message volumes. The 
Exchange 2007 Mailbox Store Message Trends by Server report uses the EXSPI-8X Dc-IS 
Mailbox Performance policy and the following metrics from the data store:

— MBDELIVER

— MBSENT

— MBSUBMITTED

— MBRECIPIENT

— MBLOCALDELIVER

• Exchange 2007 Public Folder Messaging Trends by Server — This report contains 
summary and detail trend graphs showing Public Folder Store message volumes. The  
Exchange 2007 Public Folder Messaging Trends by Server report uses the EXSPI-8X 
Dc-IS Public Folder Performance policy and the following metrics from the data store:

— PFDELIVER

— PFSENT

— PFSUBMITTED

— PFRECIPIENT

• Exchange 2007 Users and Connections by Server — This report provides a graph of the 
average number of users and connections counts for hours of the day over a given time 
period. The Exchange 2007 Users and Connections by Server report uses the EXSPI-8X 
Dc-Information Store Performance  policy and uses the following metrics from the data 
store:

— ISUSERCNT

— ISACTIVEUSERCNT

— ISANONUSERCNT

— ISACTIVEANONUSERCNT

— ISCONNECTCNT

— ISACTIVECONNECTCNT

• Exchange 2007 POP3 Connections by Server — This report provides a graph of the 
average POP3 connections count for hours of the day over a given time period. The 
Exchange 2007 POP3 Connections by Server report uses the EXSPI-8X Dc-POP3 
Performance policy and uses the following metrics from the data store:

— POP3CON

— POP3FAILEDCON
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— POP3REJECTEDCON

• Exchange 2007 IMAP4 Connections by Server — This report provides a graph of the 
average IMAP4 connections counts for hours of the day for a given time period. The 
Exchange 2007 IMAP4 Connections by Server report uses the EXSPI-8X Dc-IMAP4 
Performance policy and uses the following metrics from the data store:

— IMAP4CON

— IMAP4FAILEDCON

— IMAP4REJECTEDCON

• Exchange 2007 SMTP Receive Messaging Trends by Server — This report provides a 
graphs showing the volume of simple mail transport protocol (SMTP) messages received 
by the receive connectors on transport servers. The Exchange 2007 SMTP Receive 
Messaging Trends by Server report uses the EXSPI-8X Dc-SMTP Performance for 
Inbound Connections policy and uses the following metrics from the data store:

— SMTPMSGSENT

— SMTPMSGRECEIVE

— SMTPMSGBYTESENT

— SMTPMSGBYTERECEIVE

• Exchange 2007 SMTP Send Messaging Trends by Server — This report contains trend 
graphs showing the volume of simple mail transport protocol (SMTP) messages sent by 
the send connectors on transport servers. The Exchange 2007 SMTP Send Messaging 
Trends by Server report uses the EXSPI-8X Dc-SMTP Performance for Outbound 
Connections policy and uses the following metrics from the data store:

— SMTPMSGSENT

— SMTPMSGRECEIVE

— SMTPMSGBYTESENT

— SMTPMSGBYTERECEIVE

Reports for Exchange 2003 Servers 

Client Access

• Exchange 2003 ActiveSync Notifications

• Exchange 2003 ActiveSync Usage

• Exchange 2003 and 2000 IMAP4 Connections

• Exchange 2003 and 2000 Messaging Ports Availability

• Exchange 2003 and 2000 OWA Authentications

• Exchange 2003 and 2000 OWA Connections

• Exchange 2003 and 2000 Usage

• Exchange 2003 and 2000 POP3 Connections

• Exchange 2003 OMA Sync Usage
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Exchange Server

• Exchange 2003 and 2000 System Information Summary: Contains summary 
information about the OS and Exchange versions, mailboxes and public folders.

Information Store

• Exchange 2003 and 2000 Full Text Indexing Stats

• Exchange 2003 and 2000 IS Users and Connections

• Exchange 2003 and 2000 Transaction Log Stats: Provides information concerning 
usage and availability of storage, by and for the Exchange Transaction log.

Mailbox Store

• Exchange 2003 and 2000 Inactive Mailboxes: This report lists all the mailboxes on 
the server that have not been accessed. The report also lists mailboxes that have not been 
accessed in 20, 40 and 60 or more days.

• Exchange 2003 and 2000 Mailbox Details: Provides detailed information about the 
mailboxes on the server including summary totals, size distribution, and top mail users.

• Exchange 2003 and 2000 Mailbox Store Msg Trends

• Exchange 2003 and 2000 Mailbox Store Stats: Provides database volume statistics for 
Mailbox Store database files, for each managed Exchange Server. The report gives a 
snapshot of the volume usage, as of the most recent data collection.

• Exchange 2003 and 2000 Mailbox Summary: Provides summary information about 
the mailboxes on the server including summary totals, size distribution, and top mail 
users.

• Exchange 2003 and 2000 Mailbox Usage Trends: Contains graphs showing trends in 
database size, number of messages, and average size of mailboxes. The trends are 
associated per storage group and are shown for the time period selected when the report is 
generated.

• Exchange 2003 and 2000 Top 100 Mailboxes: Lists the top 100 mailboxes by disk 
space usage across all mailbox databases.

Messaging

• Exchange 2003, 2000, and 5.5 Message Delivery SLA (Service Level Agreement): 
Provides a trend graph showing how message delivery, messages read, and directory read 
service levels are being met across all monitored connections.

• Exchange 2003, 2000, and 5.5 Top Destinations: Identifies the top Email destinations 
(local, other Exchange sites, internet, gateway) for Email being sent by an Exchange 
server.

• Exchange 2003, 2000, and 5.5 Top Recipients: Identifies the top recipients of Email 
for an Exchange server.

• Exchange 2003, 2000, and 5.5 Top Senders: Identifies the top senders of Email for an 
Exchange server. Only Email sent by users that have Exchange mailboxes is counted. 
Email sent by clients such as Netscape and UNIX that do not have a corresponding 
Exchange mailbox are not counted. 
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• Exchange 2003, 2000, and 5.5 Top Sources: Identifies the top Email sources (local, 
other Exchange sites, internet, gateway) for Email being received by an Exchange server.

• Exchange 2003 and 2000 Message Delivery SLA from Tracking Log data

• Exchange 2003 and 2000 Message Tracking Log Space Usage

• Exchange 2003 and 2000 MTA Msg Trends: Provides trend graphs showing messaging 
volume for the Message Transfer Agent, Information Store and SMTP server message 
volume.

• Exchange 2003 and 2000 MTA Queue Data Stats

• Exchange 2003 and 2000 SMTP Connections

• Exchange 2003 and 2000 SMTP Msg Trends 

• Exchange 2003 and 2000 SMTP Virtual Server Data Stats

Public Folder Store

• Exchange 2003 and 2000 Folder Summary: Provides summary information about the 
public folders on the server.

• Exchange 2003 and 2000 Folder Usage Trends: Contains graphs showing trends in 
database size, number of messages and average size of public folders. The trends are 
shown for the time period selected when the report is generated.

• Exchange 2003 and 2000 Inactive Folders: This report lists all the folders on the 
server that have not been accessed. The report also lists folders that have not been 
accessed in 20, 40 and 60 or more days.

• Exchange 2003 and 2000 Public Folder Store Msg Tnd:

• Exchange 2003 and 2000 Public Folder Store Stats: Provides database volume 
statistics for Public Folder Store database files, for each managed Exchange Server. The 
report gives a snapshot of the volume usage, as of the most recent data collection. 

• Exchange 2003 and 2000 Top 100 Public Folders: Lists the top 100 public folders by 
disk space usage.

Reports for Exchange 2000 Servers 

Chat

• Exchange 2000 Chat Trends: Provides averaged information on the number of client 
chat connections and channels for hours of the day over the time period indicated.

Conferencing

• Exchange 2000 Conferencing Trends: Provides averaged information on the number 
of conferences and active MCUs for hours of the day over the time period indicated.

• Exchange 2000 MCU Trends: Provides averaged information on the number of 
conferences and active MCU's for hours of the day over the time period indicated.

Client Access

• Exchange 2003 and 2000 IMAP4 Connections
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• Exchange 2003 and 2000 Messaging Ports Availability

• Exchange 2003 and 2000 OWA Authentications

• Exchange 2003 and 2000 OWA Connections

• Exchange 2003 and 2000 Usage

• Exchange 2003 and 2000 POP3 Connections

Exchange Server

• Exchange 2003 and 2000 System Information Summary: Contains summary 
information about the OS and Exchange versions, mailboxes and public folders.

Information Store

• Exchange 2003 and 2000 Full Text Indexing Stats

• Exchange 2003 and 2000 IS Users and Connections

• Exchange 2003 and 2000 Transaction Log Stats: Provides information concerning 
usage and availability of storage, by and for the Exchange Transaction log.

Instant Messaging

• Exchange 2000 Instant Messaging Availability Trends: Shows instant messaging 
usage trends.

• Exchange 2000 Instant Messaging Users Growth: Shows the number of users that 
are Instant Messaging enabled over the time period indicated.

Mailbox Store

• Exchange 2003 and 2000 Inactive Mailboxes: This report lists all the mailboxes on 
the server that have not been accessed. The report also lists mailboxes that have not been 
accessed in 20, 40 and 60 or more days.

• Exchange 2003 and 2000 Mailbox Details: Provides detailed information about the 
mailboxes on the server including summary totals, size distribution, and top mail users.

• Exchange 2003 and 2000 Mailbox Store Msg Trends

• Exchange 2003 and 2000 Mailbox Store Stats: Provides database volume statistics for 
Mailbox Store database files, for each managed Exchange Server. The report gives a 
snapshot of the volume usage, as of the most recent data collection.

• Exchange 2003 and 2000 Mailbox Summary: Provides summary information about 
the mailboxes on the server including summary totals, size distribution, and top mail 
users.

• Exchange 2003 and 2000 Mailbox Usage Trends: Contains graphs showing trends in 
database size, number of messages, and average size of mailboxes. The trends are 
associated per storage group and are shown for the time period selected when the report is 
generated.

• Exchange 2003 and 2000 Top 100 Mailboxes: Lists the top 100 mailboxes by disk 
space usage across all mailbox databases.
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Messaging

• Exchange 2003, 2000, and 5.5 Message Delivery SLA (Service Level Agreement): 
Provides a trend graph showing how message delivery, messages read, and directory read 
service levels are being met across all monitored connections.

• Exchange 2003, 2000, and 5.5 Top Destinations: Identifies the top Email destinations 
(local, other Exchange sites, internet, gateway) for Email being sent by an Exchange 
server.

• Exchange 2003, 2000, and 5.5 Top Recipients: Identifies the top recipients of Email 
for an Exchange server.

• Exchange 2003, 2000, and 5.5 Top Senders: Identifies the top senders of Email for an 
Exchange server. Only Email sent by users that have Exchange mailboxes is counted. 
Email sent by clients such as Netscape and UNIX that do not have a corresponding 
Exchange mailbox are not counted. 

• Exchange 2003, 2000, and 5.5 Top Sources: Identifies the top Email sources (local, 
other Exchange sites, internet, gateway) for Email being received by an Exchange server.

• Exchange 2003 and 2000 Message Delivery SLA from Tracking Log data

• Exchange 2003 and 2000 Message Tracking Log Space Usage

• Exchange 2003 and 2000 MTA Msg Trends: Provides trend graphs showing messaging 
volume for the Message Transfer Agent, Information Store and SMTP server message 
volume.

• Exchange 2003 and 2000 MTA Queue Data Stats

• Exchange 2003 and 2000 SMTP Connections

• Exchange 2003 and 2000 SMTP Msg Trends 

• Exchange 2003 and 2000 SMTP Virtual Server Data Stats

Public Folder Store

• Exchange 2003 and 2000 Folder Summary: Provides summary information about the 
public folders on the server.

• Exchange 2003 and 2000 Folder Usage Trends: Contains graphs showing trends in 
database size, number of messages and average size of public folders. The trends are 
shown for the time period selected when the report is generated.

• Exchange 2003 and 2000 Inactive Folders: This report lists all the folders on the 
server that have not been accessed. The report also lists folders that have not been 
accessed in 20, 40 and 60 or more days.

• Exchange 2003 and 2000 Public Folder Store Msg Tnd:

• Exchange 2003 and 2000 Public Folder Store Stats: Provides database volume 
statistics for Public Folder Store database files, for each managed Exchange Server. The 
report gives a snapshot of the volume usage, as of the most recent data collection. 

• Exchange 2003 and 2000 Top 100 Public Folders: Lists the top 100 public folders by 
disk space usage.
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Reports for Exchange 5.5 Servers 

Exchange Server

• Exchange 5.5 System Information Summary: Contains summary information about 
the OS and Exchange versions, mailboxes and public folders. 

Information Store

•  Exchange 5.5 User Connections 

Mailbox Database

• Exchange 5.5 Mailbox Details: Provides detailed information about the mailboxes on 
the server. 

• Exchange 5.5 Mailbox Summary: Provides summary information about the mailboxes 
on the server including summary totals, size distribution, and top mail users.

•  Exchange 5.5 Mailbox Usage Trends: Contains graphs showing trends in database 
size, number of messages, and average size of mailboxes. The trends are associated per 
storage group and are shown for the time period selected when the report is generated. 

• Exchange Top 100 Mailboxes: Lists the top 100 mailboxes by disk space usage.

Messaging

• Exchange 2003, 2000, and 5.5 Message Delivery SLA (Service Level Agreement): 
Provides a trend graph showing how message delivery, messages read, and directory read 
service levels are being met across all monitored connections.

• Exchange 2003, 2000, and 5.5 Top Destinations: Identifies the top Email destinations 
(local, other Exchange sites, internet, gateway) for Email being sent by an Exchange 
server.

• Exchange 2003, 2000, and 5.5 Top Recipients: Identifies the top recipients of Email 
for an Exchange server.

• Exchange 2003, 2000, and 5.5 Top Senders: Identifies the top senders of Email for an 
Exchange server. Only Email sent by users that have Exchange mailboxes is counted. 
Email sent by clients such as Netscape and UNIX that do not have a corresponding 
Exchange mailbox are not counted. 

• Exchange 2003, 2000, and 5.5 Top Sources: Identifies the top Email sources (local, 
other Exchange sites, internet, gateway) for Email being received by an Exchange server.

• Exchange 5.5 IMS Messaging Trends: Provides trend graphs showing messaging 
volume for the Internet Mail Service

•  Exchange 5.5 Messaging Trends 

•  Exchange 5.5 Messaging Trends For All Servers 

Public Folder Database

•  Exchange 5.5 Folder Summary: Provides summary information about the public 
folders on the server. 

•  Exchange 5.5 Folder Usage Trends 
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•  Exchange Top 100 Public Folders: Lists the top 100 public folders by disk space 
usage.
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Using Exchange 5.5 Reports and Graphs

Exchange SPI report and graph generation require that you complete the following:

• Distribute the data collection policies.

• Configure and distribute Exchange SPI reporter collection policies.

Distributing the Data Collection Policies

In order to collect data for reports and graphs the General Data Collection policies in the 
Quick Start (Exchange 5.5) and EXSPI OVO Exchange SPI core (Exchange 2000 and 2003) 
policy groups need to be distributed.

For the procedure to distribute policies, see Assign/Distribute Policies on page 53.

Configure/Distribute Reporter Collection Policies 

For any Exchange server system on which you would like to receive reports, you need to 
distribute Exchange SPI policies from the EXSPI Advanced > EXSPI Reporter Collection 
group.

To configure the Reporter Collection policies two steps are required:

1 Complete the Advanced Configuration procedure.

2 Distribute Reporter Collection policies.

1. Complete the Advanced Configuration procedure

For detailed steps, see Configuring the Exchange SPI on page 46.

2. Distribute Reporter Collection policies

The reporter collection policies need to be distributed to any managed nodes where data is to 
be collected for reporting and graphing. For the procedure to distribute policies, see Assign/
Distribute Policies on page 53.

Deinstalling Exchange SPI Reporter

Remove the Exchange SPI reporter in one of the following ways:

1 Using the Windows Start menu.

2 Using the EXSPI-Reporter InstallShield wizard.

Time Interval for Exchange SPI Reports or Graphs

Exchange SPI reports and graphs will not be available until data has been gathered to the 
management server from the managed nodes. This occurs each night, so at least one day of 
activity is needed for the reports to populate. Where a report or graph type requires data from 
a Sat/Sun collection, those reports/graphs will require a weekend to pass.
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Using the Windows Start menu:

1 Select Start > Settings > Control Panel > Add/Remove Programs.

2 Select EXSPI-Reporter.

3 Click Remove. 

Using the EXSPI-Reporter InstallShield wizard.

1 Double-click EXSPI-Reporter.msi. This opens the EXSPI-Reporter InstallShield 
Wizard. Click Next on the Welcome screen.

2 Confirm the next screen by clicking Remove.

3 The InstallShield Wizard has deinstalled EXSPI-Reporter. Click Finish.
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Exchange SPI OVPM Graphs

Exchange SPI comes with a set of preconfigured graph policies. These graph policies need to 
be installed on an OVPM system, and require that OpenView PerfAgent (MW Agent) is 
running on the managed node.

Installing Exchange SPI Graph policies

There are three policy files: VPI_GraphsEXSPI2K.txt for Exchange 2000 OVPM graphs, 
VPI_GraphsEXSPI2K3.txt for Exchange 2003 OVPM graphs, and VPI_GraphsEXSPI55.txt 
for Exchange 5.5 OVPM graphs. 

These files are located:

— on the OVO for UNIX management server at  /var/opt/OV/share/databases/
OpC/mgd_node/customer/ms/intel/nt/cmds 

— on the Exchange SPI managed nodes

– on DCE nodes at \usr\OV\bin\OpC\intel\cmds 

– on HTTPS nodes at OVO-DATADIR>\bin\instrumentation 

To install the EXSPI graph policies on an OVPM 5.0 system, copy these files to the graph 
policy installation directory on the OVPM system:

— on Windows OVPM systems to <OVInstallDir>/newconfig/OVPM 

— on UNIX OVPM systems to $OvInstallDir/newconfig/OVPM 

Then follow the installation procedures outlined in the OpenView Performance Manager 
Administrator's Guide in the "Editing Graph Policy Files Directory" section.

Once installed these graphs are located in the Application Bank under: EXSPI Admin.

When setup is complete, the following graphs are available:
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Exchange 2003 OVPM Graphs

Exchange SPI graphs are located in the following folders: 

• Client Access

• Directory Service

• Information Store

• Mailbox Store

• Messaging

• Public Folder Store

Client Access 

ActiveSync Performance: This graph shows the ActiveSync Microsoft Exchange active 
directory, connection, and pending requests. 

ActiveSync Users: This graph shows the current users of Microsoft Exchange 
ActiveSync. 

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Latency levels: This graph shows the number of successful RPCs with 
Outlook client latency levels.

MAPI RPC Performance: This graph shows metrics of information store RPC requests 
and RPC operations rate (operations/sec). 

Number of Successful RPCs with Different Latency Levels: This graph shows the 
number of successful RPCs with different Outlook client latency levels. 

Outlook Client RPC Performance: This graph shows the Outlook Client RPC 
Performance. 

OWA Connections: This graph shows the OWA connection activity. 

OMA Response Time: This graph shows the MSExchangeOMA last response time in 
seconds. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache hit 
and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space on 
the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service space 
usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 
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Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the information 
store virtual memory largest block size. 

Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log space 
usage on the Exchange server. 

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 service 
MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 
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Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 

Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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Exchange 2000 OVPM Graphs

Exchange 2000 graphs are arranged in the following service groups:

• Client Access

• Directory Service

• Information Store

• Mailbox Store

• Messaging

• Public Folder Store

Client Access

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Performance: This graph shows metrics of information store RPC requests 
and RPC operations rate (operations/sec). 

OWA Connections: This graph shows the OWA connection activity. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache hit 
and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space on 
the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service space 
usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 

Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 

Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log space 
usage on the Exchange server. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the information 
store virtual memory largest block size. 
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Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.

Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 

SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 service 
MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 

Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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Exchange 5.5 OVPM Graphs

The Exchange 5.5 graphs are organized in the following categories:

Information Store 

Delivery: This graph shows hourly metrics for the average delivery times of messages to 
Exchange server private and public mailboxes.

Users: This graph shows information store user count metrics, for the current day.

Mailbox Database

Mailbox Usage: This graph shows Exchange server mailbox usage.

Private Mailbox Volume: This graph shows Exchange server private mailbox volume.

Messaging

Internet Mail Queue: This graph shows the Exchange server Internet Mail Service 
queue count. 

Internet Mail Volume: This graph shows Exchange server Internet Mail Connector 
volume. 

MTA Volume: This graph shows Exchange server Message Transfer Agent volume. 

Newsfeed Volume: This graph shows Exchange server newsfeed volume. 

Queues: This graph shows Exchange server queue lengths. 

Public Folder Database

Public Folder Usage: This graph shows Exchange server public folder usage.

Public Folder Database: This graph shows Exchange server public folder volume.
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Additional Exchange 5.5 PerfView Graphs in the Application Bank 

In the 10.00 release there is a set of preconfigured graphs for Exchange 5.5 that can be viewed 
in HP PerfView. PerView graphs require that an OpenView Performance Agent (also known as 
MeasureWare Agent) is running on the managed node.

These graphs are located in the Application Bank, under Exchange 5.5 Graphs, in the 
following groups:

• Information Store

• Messaging

• System Information

• Transaction Log Disk Space

Information Store

Delivery: This graph shows hourly metrics for the average delivery times of messages to 
Exchange Server private and public mailboxes.

Mailbox Usage: This graph shows Exchange Server Mailbox usage.

Mailbox Volume: This graph shows Exchange Server Mailbox volume.

Public Folder Usage: This graph shows Exchange Server Public Folder usage.

Public Folder Volume: This graph shows Exchange Server Public Folder volume.

Users: This graph shows information store user count metrics for the current day.
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Messaging

Internet Mail Queue: This graph shows the Exchange Server Internet Mail Service queue 
count. 

Internet Mail Volume: This graph shows Exchange Server Internet Mail Connector volume. 

MTA Volume: This graph shows Exchange Server Message Transfer Agent volume. 

Newsfeed Volume: This graph shows Exchange Server newsfeed volume. 

Queues: This graph show Exchange Server queue lengths. 

System Information

System Information for the following areas of performance are made available in graph 
format:

— NT CPU
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— NT Disk

— NT History

— NT Memory

— NT Network

Transaction Log Disk Space 

This graph shows Transaction Log Disk Space usage on Exchange 5.5 servers.
130 Chapter 7



8 Troubleshooting
Introduction

This chapter offers troubleshooting suggestions for Exchange SPI. It includes the following 
sections:

• Self-Healing Information for enhanced troubleshooting

• Verifying Software Installation on the Management Server

• The Exchange SPI Error Log

• Turning on/ Disabling Tracing

• Common Errors

• Verifying the MSXSPI account has the right privileges 

• Verifying MeasureWare Integration

• Installing Old DSI Log Files

• Advanced Configuration Policy Failures

• Exchange Service Discovery errors
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Self-Healing Information for Enhanced Troubleshooting

The Exchange SPI now includes a Self-Healing Info application that gathers data useful for 
troubleshooting issues. The application can be launched on the managed node to gather 
specific error messages, and other relevant data that can help you diagnose problems. 

Even though the Self-Healing Info application can work independently, it can also be 
integrated with HP OpenView Self-Healing Services, available at no cost with your support 
contract. Self-Healing Services speeds up the problem resolution process by allowing you to 
easily open an incident and send data straight to a secure HP support site. For more 
information, see HP OpenView’s Software Support Online Web site at:

http://support.openview.hp.com/self_healing.jsp

After you install the Self-Healing Services client on the managed node, you no longer need to 
launch the Self-Healing Info application. Self-Healing Services automatically gathers 
error-related and system data when you submit an incident.

Using the Self-Healing Info application

1 Turn on tracing, see Turning on Tracing on page 135.

2 Reproduce your problem.

3 Open the Node Bank window and locate the node on which you want to run the 
Self-Healing Info application.

4 Open the Application Bank window and double-click EXSPI.Admin.

5 Drag and drop the node onto the Self-Healing Info application.

6 In the message that appears, note where the compressed file will be stored.

7 Send the file to the above-mentioned HP support site for diagnosis.

If Self-Healing Services is already installed, you will have to re-start it after 
installing your SPI. Whenever possible, install the SPI before installing Self-Healing 
Services. An upgrade to SPIs on a managed node already running Self-Healing 
Services requires a re-start of Self-Healing Services.
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Verifying Exchange SPI Installation on the Management Server

To check the integrity of Exchange SPI files on the OVO management server, run the 
following command: 

/usr/sbin/swverify SPI-EXCHANGE-OVO

This command produces output similar to the following:

 (non-interactive) (jobid=ovruxr13-0161)
       * Session started for user "root@ovruxr13".
       * Beginning Selection
       * Target connection succeeded for "ovruxr13:/".
       * Software selections:
+ DSI2DDF.DSI2DDF,l=/,r=A.02.00.00,a=HP/SunOS,v=HP
SPI-EXCHANGE-OVO.EXSPI,l=/,r=A.08.20.6,a=HP-UX_B.11.00_32/
HP-UX_B.11.00_64,v=HP
+SPI-SHS-OVO.SPI-SHS-AIX,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SHS-OVO.SPI-SHS-CORE,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SHS-OVO.SPI-SHS-HPUX,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SHS-OVO.SPI-SHS-LXx86,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SHS-OVO.SPI-SHS-OSF,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SHS-OVO.SPI-SHS-SOL,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SHS-OVO.SPI-SHS-UX64,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SHS-OVO.SPI-SHS-WIN,l=/,r=A.01.00.00,a=HP_UX_10/11,v=HP
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-AIX,l=/
,r=A.02.00,a=HP_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
           +SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-HP,l=/
,r=A.02.00,a=HP_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-LNX,l=/
,r=A.02.00,a=HP_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-SOL,l=/
,r=A.02.00,a=HP_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-TRU64,l=/
,r=A.02.00,a=HP_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-AGT-WIN,l=/
,r=A.02.00,a=HP_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
+SPI-SVCDISC-OVO.SPI-SVCDISC-SRV-HP,l=/
,r=A.02.00,a=HP_UX_11,v=HP,fr=A.02.00,fa=HP_UX_11
       * A "+" indicates an automatic selection due to dependency or the 
automatic selection of a patch or reference bundle.
       * Selection succeeded.
       * Beginning Analysis
       * Session selections have been saved in the file:
        /root/users/afshinsu/.sw/sessions/swverify.last
NOTE: More information may be found in the agent logfile using the 
command 
swjob -a log ovruxr13-0161 @ ovruxr13:/

This utility is not available for Sun Solaris
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The Exchange SPI Error Log

OVO7 and OVO8/DCE errors are forwarded to the browser and logged to:

\usr\OV\exspi\log\exspierror

OVO8/HTTPS errors are logged to:

<Installation_Directory>\Data\exspi\log\exspierror 

For example:

04/01/02 08:43:57 ERROR exspi(488) [colamain.cpp:333]: EXSPI-60-40:
Exchange Server Software not installed on this system (Check: 
SOFTWARE\Microsoft\Exchange\Setup). Unable to perform collection!
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Turning on Tracing

If a problem occurs and you are asked to turn on tracing by the EX-SPI support team, use the 
Enable EXSPI Tracing application for the relevant Exchange version. 

1 Select all the Exchange managed nodes you wish to configure in the OVO Node Bank.

2 Drag and drop these nodes on the Enable EXSPI Tracing application located in the 
EXSPI Admin application group under the appropriate version.

3 Verify whether there are any errors in the Output of Application window.

Figure 47 Output of Application window
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Disabling Tracing

For disabling the tracing, use Disable EXSPI Tracing.

The trace file will grow very large. It is advisable to leave tracing enabled only long 
enough to recreate the problem, or in order to comply with HP support instructions.
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Common Errors

1 When re-installing or upgrading Exchange Server, Exchange Setup program shows errors.

Symptom: Exchange Server re-install or upgrade (e.g., new Service Pack), the 
Exchange Setup generates error messages about DLLs that can't be overwritten.

Solution: Stop OVO (opcagt -stop) and MeasureWare (mwacmd stop), then retry 
the operation.

2 Schedule policy fails with message:
EXSPI xxxxx Metric Collection failed.

Symptom: The scheduled command failed with an exit code other than 0.

Solution: This error sometimes occur if the system is rebooted just before the 
collector/analyzer program was executed. 

However, if this is not the case do the following: To find out more information about the 
failure, modify the failing schedule policy, check the Send Output of Action check box and 
re-distribute policies again.

The browser message should now contain an annotation with more information about the 
failure. Also, check the exspierror for more information.

3 Error when distributing Exchange 5.5 ConfigFile policies to Windows NT4 managed 
nodes.

Symptom: During ConfigFile policy distribution to Windows NT nodes, the following 
system error message box appears and the action fails:

      OvCfgFile.exe - Entry Point Not Found. The procedure entry point 
__lc_collate_cp could not be located in the dynamic link library 
MSVCRT.dll.

Solution: The Windows managed node does not have the correct version of the 
Microsoft C Runtime library MSVCRT.dll installed on the managed node 
(MSVCRT.dll is located in the system32 directory). Upgrade your system by 
downloading and installing a newer version of MSVCRT.dll as described in Microsoft 
Knowledge Base article Q259403 at:     www.support.microsoft.com/
default.aspx?scid=kb;EN-US;q259403 Updating MSVCRT.dll may require a 
reboot. Afterwards, restart the failed ConfigFile-policy distribution.
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Verifying MSXSPI account has right privileges

In order to verify that you have created the MSXSPI account with the right amount of 
privileges to run advanced metrics such as 5, 841, or 630, do the following:

1 Log into your Exchange 2000 or 2003 server as MSXSPI user (in the correct NT domain).

2 Open a DOS command prompt window.

3 cd to the directory where exspi collector is located (for OVO7 and OVO8/DCE typically in 
c:\usr\OV\bin\OpC\monitor, for OVO8/HTTPS 
<InstallDir>\data\bin\instrumentation).

4 Run the following series of commands:

exspi_e2k.exe  -m 5   -p

exspi_e2k.exe  -m 841   -p

exspi_e2k.exe  -m 630   -p

5 These will print the results to the screen.

6 If these executed properly and the correct results printed on the screen, your MSXSPI 
account has the right permissions.
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Verifying MeasureWare Integration

To verify MeasureWare integration check the following:

1 Is the MeasureWare Agent installed on the Exchange server managed node?

2 Is the MeasureWare agent up and running (mwacmd status or MeasureWare Agent 
application in RPM Tools Windows group)? There should be TWO rep_server programs 
running. If not, re-start MeasureWare Agent.

3 Verify MeasureWare Agent configuration.

a Verify that perflbd.mwc (e.g., in \rpmtools\data) contains EXSPI_DATA data 
source.

b If not, re-run MW setup: First run, Disable Data Logging, wait for MW to re-start, 
then run Enable Data Logging.

c Verify that DSI logfiles were created in \usr\exspi\dsi\log\EXSPI_DATA

d Check the timestamps of those files; they are updated when the data collectors run.

4 Verify exspi_e2k.exe or exspi_e55.exe data forwarding:

— For OVO7 and OVO8/DCE the collector/analyzer exspi_e2k.exe or 
exspi_e55.exe specified in the schedule policies writes MeasureWare data to 
\usr\OV\exspi\dsi\*.dat only if the keyword MW ON is present in the 
\usr\OV\exspi\defaults file (Note: the defaults file has no file extension.). Check 
the defaults file for the above keyword. If not present, run EXSPI Add DataSource.

— For OVO8/HTTPS the collector/analyzer exspi_e2k.exe or exspi_e55.exe 
specified in the schedule policies writes MeasureWare data to 
<InstallDir>data\exspi\dsi\*.dat only if the keyword MW ON is present in the 
<InstallDir>data\exspi\defaults file. (Note: the defaults file has no file 
extension.). Check the defaults file for the above keyword. If not present, run EXSPI 
Add DataSource.

5 Check whether *.dat files are present in \usr\OV\exspi\dsi. (for OVO7 and OVO8/
DCE), or <InstallDir>data\exspi\dsi (for OVO8/HTTPS).

6 Check timestamps of *.dat files.
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Advanced Configuration Policy Failures

Symptom: 

The following data collectors fail and a critical message is shown in the OVO  browser:

— EXSPI 6X/55 Dc-Private IS Sum. Data

— EXSPI-6X/55 Dc-Public IS Sum. Data

— EXSPI-6X/55 Dc-Mailbox Data

— EXSPI-6X/55 Dc-Public Folder Data

Solution: 

These collectors access Exchange directly and require MSXSPI user and 
MSXSPI<hostname> mailbox.

1 Verify MSXSPI user, MSXSPI<hostname> mailbox, MSXSPI rights in Exchange and 
MeasureWare:

2 Verify MSXSPI user setup.

— Use Windows User Manager to verify MSXSPI account. The user must exist in the 
same domain as that which the Exchange Server is part of. Note: there must be no 
local MSXSPI user.

— For Exchange 5.5, the MSXSPI user must be part of Domain Admin group.

3 Verify MSXSPI rights in Exchange.

The MSXSPI user must have "Receive As" and "Send As" Exchange Admin permissions. See 
Creating a Service Account with Proper Access Permissions on page 25.

4 Verify MSXSPI<hostname> mailbox.

Use Exchange Admin to verify that a MSXSPI<host_name> mailbox exists and click on 
Recipients. In the right pane, a MSXSPI<host_name> user must show up for each server 
which belongs to the site.

5 Verify MeasureWare Agent integration as described in Verifying MeasureWare 
Integration on page 139.
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Exchange Service Discovery Failures

Symptom: 

The error message: 

Error: Specified file was not found

Solution: 

Verify that the distribution of Exchange SPI commands was successful. Refer to Distribute 
the Exchange SPI Actions, Monitors, and Commands on page 47.

Symptom: 

Exchange SPI service discovery fails.

Solution: 

The following patches allow more than one instance of opctranm:

PHSS_28148 – OVO A.07.12 HP-UX 11.0/11.11

ITOSOL_00183 – OVO A.07.12 Solaris

If you do not have these, or the patches that supersede them, the Exchange SPI discovery may 
fail if there is an instance of opctranm running already.

To resolve this, wait till the opctranm job is completed before starting Exchange SPI discovery 
(or) kill the opctranm process.

Symptom: 

The error message: Problem in Executing opcservice

Solution: 

Check if the OVO Service Navigator Component is installed.

The OVO Service Navigator Component component is included on the CD with the OVO 
bundle
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A File Names
Introduction

This chapter lists the Exchange SPI file names, along with their descriptions, owners, groups, 
and permissions. Exchange SPI files are grouped as follows:

• Management server files

• Management server/managed node files

• Managed node files

• Logging and trace files
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Management Server Files

Policies for opccfgupld (OVO Upload Facility)

All files listed in this table can be found on the management server in the following directories 
(the location of these files varies by platform):

/var/opt/OV/share/tmp/OpC_appl/EXSPI/exspiset/C/

Table 5 Management Server Files

File Description

exspiset.idx OVO upload control file. This 
file defines what is being 
uploaded into OVO: message 
groups, monitor policies, logfile 
policies, applications and policy 
groups.

TEMPLATES/LOGFILE
/logfile.dat

Definition file for logfile 
encapsulation. 

TEMPLATES/MONITOR
/monitor.dat

Definition file for OVO policies: 
collector/analyzer program, 
external monitor for each metric 
and file system monitor. Contains 
all details for monitoring all 
metrics.

TEMPLATES/SCHEDULE
/schedule.dat

Definition file for Exchange SPI 
schedule policies.

TEMPLATES/TEMPLGROUP
/templgrp.dat

Definition file for OVO policy 
group structure.

TEMPLATES/MSGGROUPS
/msggrps.dat

Definition file for OVO message 
group structure.

TEMPLATES/INTERFACE
/msgi.dat

Definition file for Exchange SPI 
specific error message.
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Miscellaneous Management Server Files

Table 6 Miscellaneous Other Management Server Files

File Description

/etc/opt/OV/share/conf
/OpC/mgmt_sv/
reports/exspi_lc.sql

Report that lists all nodes that have 
Exchange SPI policies assigned (for license 
check).

/opt/OV/EXSPI/bin/exspipv Script to run PerfView as metric operator 
actions and bring up graphs.

/opt/OV/EXSPI/bin/exspircfg                         Script for EXSPI Node Config.

/opt/OV/EXSPI/bin/EXSPI_DiscConfig.sh            Script for setting Exchange SPI related 
variables. 

/opt/OV/EXSPI/bin/exspipngcfg_e55.sh        Script for End-to-End Ping config for 
Exchange 5.5

/opt/OV/EXSPI/bin/exspipngcfg_e2k.sh        Script for End-to-End Ping config for 
Exchange 2000 and 2003
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Management Server/Managed Node Files

When you run swinstall, the following monitor and command files are installed on the 
Management Server. They are also installed on managed nodes when you distribute monitors, 
commands and actions from the Management Server to the managed nodes.

Monitor Files

On Management Server:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/
intel/nt/monitor/  (for DCE)

and

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/x86/ winnt/monitor/ 
(for HTTPS)

On Managed Node:

\usr\OV\bin\OpC\monitor (for DCE)

and

<OVO-DATADIR>\bin\instrumentation (for HTTPS)

Table 7 Monitor Files 

 File  Description

exspi_e2k.exe  Exchange 2000/2003 SPI Collector/Analyzer 
program.

exspi_e55.exe  Exchange 5.5 SPI Collector/Analyzer program.

msexchange.apm.xml Policy list for cluster fail-over

OVAMTLog2k.dll  Tracking.Log access library for Exchange 2000/
2003

OVAMTLog55.dll  Tracking.Log access library for Exchange 5.5

OVAMDa.dll  LDAP access library

hpudm.txt  Internal data file

end-to-end.xml End-to-End configuration file

All files in Table 3: Monitor Files, are in compressed ".Z" format to improve distribution 
performance.
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Command Files 

Command files are located in the following directories:

Management Server:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/
intel/nt/cmds  (for DCE)

and

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/

x86/winnt/cmds (for HTTPS)

Managed Node:

\usr\OV\bin\OpC\intel\cmds (for DCE)

and

<OVO-DATADIR>\bin\instrumentation  (for HTTPS)

All files in this table are in compressed ".Z" format to improve distribution performance.

Table 8 Command Files

File Description

exspitra.vbs Turns EXSPI Tracing on/off
-v ON
-v OFF

exspimwd.vbs Turns data forwarding to MeasureWare on/off (collector/
analyzer will only forward data to MeasureWare if set to 
on:
-v ON
-v OFF

exspienc.exe For configuring managed node; part of the advanced 
configuration.

exspi_e2k_cfg.vbs For configuring an Exchange 2000 or 2003 server 
mailbox.

exspi_e55_cfg.exe For configuring an Exchange 5.5 server mailbox.

exspi_perfmon.exe For perfmon counter data logging and threshold 
alarming.

EXSPI_DataObjects.xml

EXSPI Coda data source 
and objects.doc
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EXSPI_asnotify.spec/ 
EXSPI_async.spec
EXSPI_deliv.spec/ 
EXSPI_dsaccess.spec
EXSPI_ftdata.spec/ 
EXSPI_imap4perf.spec
EXSPI_isclient.spec/ 
EXSPI_isperf.spec
EXSPI_m0660.spec/ 
EXSPI_m0661.spec
EXSPI_m0662.spec/ 
EXSPI_m0663.spec
EXSPI_m1002.spec/ 
EXSPI_mbdetail.spec
EXSPI_mbperf.spec/ 
EXSPI_mbsummary.spec
EXSPI_mtadata.spec/
EXSPI_multi.spec
EXSPI_oma.spec
EXSPI_owabe.spec
EXSPI_owafe.spec
EXSPI_pfdetail.spec
EXSPI_pfperf.spec
EXSPI_pfsummary.spec
EXSPI_pop3perf.spec
EXSPI_ports.spec
EXSPI_single.spec
EXSPI_smtpdata.spec
EXSPI_smtpq.spec
EXSPI_srs.spec
EXSPI_translog.spec

Data log specification

exspi_e2k_clust_config.js  Generates xml output, which can be used for editing the 
apminfo.xml file

exspi_dbmount.vbs 
(NOTE: This file is also present 
under monitor and actions 
directories) -

Checks and mounts dismounted information store(s)

File Description
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Windows Managed Node Files

Monitor policies

When policies are distributed from the management server to the Windows managed nodes, 
the monitor policies are encrypted and stored in the following directory:

%OVAgentDir%\conf\OpC\<hostname>\
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Logging and Trace Files

Logging and trace files are located in the following directory on the managed node:

%OVAgentDir%\exspi\log

Table 9 Logging and Trace Files

File Description

trace When TRACE ON is set in 
%OVAgentDir%\exspi\defaults, tracing and debug 
information is written to  %OVAgentDir%\exspi\log. This 
file can get very large.

exspierror Error information when the Exchange SPI collector/analyzer 
encounters an error condition. Messages written to this file are 
also sent to the OVO message browser.
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B spimetadata.xml File
The spimetadata.xml file contains the information related to the collection mechanism of 
the Exchange SPI for Microsoft Exchange Server 2007 nodes. The example below shows a 
sample spimetadata.xml file with all basic elements. It is not recommended to modify the 
spimetadata.xml file manually as incorrect modification can lead to incorrect operation of 
the Exchange SPI.

Sample spimetadata.xml File

<?xml version="1.0" encoding="utf-8"?>

<CollectionDefinitions>

  <MetricSets>

    <MetricSet>

      <Name>MetrciSet1</Name>

      <Parameters>

      </Parameters>

      <SourceDefinition>

        <Type>

        </Type>

        <Command>Get-ReplicationAge</Command>

        <DataSource>

        </DataSource>

        <DataObject>

        </DataObject>

      </SourceDefinition>

      <Metric>

        <Name>CopyQueueLength</Name>

        <Datatype>System.Int64</Datatype>

        <Description>

        </Description>

        <Type>

        </Type>

      </Metric>
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      <Metric>

        <Name>StorageGroupName</Name>

        <Datatype>System.String</Datatype>

        <Description>

        </Description>

        <Type>

        </Type>

      </Metric>

    </MetricSet>

  </MetricSets>

  <Collections>

    <Collection>

      <Name>1</Name>

      <DisplayName>New Collection</DisplayName>

      <Description>New Collection</Description>

      <Interval>00:05:00</Interval>

      <CollectionSet>

        <MetricSetNameRef>MetrciSet1</MetricSetNameRef>

      </CollectionSet>

      <Calculations />

      <Filters />

      <PublishMetrics>

        <PublishSetNameRef>Replication_Publish</PublishSetNameRef>

      </PublishMetrics>

      <AlertSets>

        <ThresholdSetNameRef>OpcMonCallForReplication</ThresholdSetNameRef>

        <AlarmSetNameRef>OpcMsgForReplicationAge</AlarmSetNameRef>

      </AlertSets>

    </Collection>

  </Collections>

<PublishedSets>

  <PublishedSet>

    <Name>Replication_Publish</Name>

    <Database>DATASOURCENAME</Database>

    <ClassName>TABLENAME</ClassName>

    <IndexBy>DAY</IndexBy>

    <RollBy>MONTH</RollBy>
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    <Capacity>720</Capacity>

    <Metrics>

      <Metric>

        <MetricRef>

          <SetNameRef>SGNAME</SetNameRef>

          <MetricNameRef>StorageGroupName</MetricNameRef>

        </MetricRef>

      </Metric>

      <Metric>

        <MetricRef>

          <SetNameRef>CPQLEN</SetNameRef>

          <MetricNameRef>CopyQueueLength</MetricNameRef>

        </MetricRef>

      </Metric>

    </Metrics>

  </PublishedSet>

 </PublishedSets>

  <AlertSets>

    <AlarmSets>

      <AlarmSet>

        <Name>OpcMsgForReplicationAge</Name>

        <Rules>

          <Rule>

            <MetricSetName>MetrciSet1</MetricSetName>

            <MetricName>CopyQueueLength</MetricName>

            <ArithmeticOperator>GreaterThan</ArithmeticOperator>

            <ValueToCompare>0</ValueToCompare>

            <LogicalOperator>LastRule</LogicalOperator>

          </Rule>

        </Rules>

        <MessageDetails>

         <Application>MyApp</Application>

          <Object>MyObj</Object>

          <Text>Sending Messge with warning as severity and  value of 
%CopyQueueLength%</Text>

          <Severity>Warning</Severity>

          <ServiceID>
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          </ServiceID>

          <MessageKey>

          </MessageKey>

        </MessageDetails>

      </AlarmSet>

    </AlarmSets>

    <ThresholdSets>

      <ThresholdSet>

        <Name>OpcMonCallForReplication</Name>

        <MetricSetName>MetrciSet1</MetricSetName>

        <MetricName>CopyQueueLength</MetricName>

        <ThresholdPolicy>Any Threshold Policy Name</ThresholdPolicy>

        <AutoBaseline IsEnable="False" />

      </ThresholdSet>

    </ThresholdSets>

  </AlertSets>

</CollectionDefinitions>

Elements of the spimetadata.xml File

The spimetadata.xml file consists of the following major elements:

MetricSets — The MetricSets element contains the following information:

• Metrics to be collected from the nodes

• Cmdlet to be used to collect the metrics

• Type of the metric data

PublishedSet —  The PublishedSet element describes the mechanism to store the metric 
data to a data store.

AlertSets — The AlertSets element contains the information on calculating the metric data 
with a threshold value and the mechanism to generate an alarm in the event of threshold 
violation.

Collections — The Collections element contains the Collection sub-element. The Collection 
sub-element holds all information on individual collection configurations. Each Collection 
element contains the following information:

• Name of the collection

• MetricSets to be used

• Mechanism to store metric data on a data store

• Mechanism to generate alarm in the event of threshold violation
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duration settings, 100
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message policies, 17
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policy groups, 15
policy groups requirements, 71
policy types, 16
re-installing, 105
Reporter Collection, 119
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severity alert setting, 100

policy failures
advanced configuration, 140

prerequisites,Service Discovery, 78

procedures
service accounts
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R
reports, 22

Exchange 2000/2003 list, 112, 114
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Self-Healing Info, 132

Self-Healing Services, 132

server connections
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service accounts
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Service account user with special Exchange 
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Service Discovery, 13, 78
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Service Views, 81
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swinstall, using to re-install policies, 105

T
thresholds

changing, 100
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without reset, 98
with reset, 98
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tmplgrp.dat, 144

trace files, 150

tracing
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permissions, how to create, 25

user privileges, 24
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